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MAC OS
CATALINA

Starting something new can be daunting. Learning a skill or
mastering a new piece of hardware is tough. Even tougher if
you have no-one at hand to help. Conversely as the complexity
of our consumer technology increases, the size of the requisite
instruction manual decreases or in some cases it simply disappears.
At numerous times in our lives we have all been “beginners’, there
is no shame in that fact and rightly so. How many times have you
asked aloud, “What does this button do?".“Why doesn’t that work?".
“What do you mean it doesn’t do that?”.“HELP!". At the start of any
new journey or adventure we are all beginners but fortunately for
you we are here to stand beside you at every stage.

Over this extensive series of titles we will be looking in great depth
at the latest consumer electronics, software, hobbies and trends
out of the box! We will guide you step-by-step through using all

aspects of the technology that you may have been previously
apprehensive at attempting. Let our expert guide help you build
your technology understanding and skills, taking you from a novice
to a confident and experienced user.

Over the page our journey begins. We would wish you luck but
we're sure with our support you won't need it.




You and Your Mac

We bring you tutorials on launching apps, using the
Desktop, setting up your email accounts and more.
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First Time User? — Start Reading Here
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Get on the Internet — With Wi-Fi or Ethernet
Gesture Controls — On Your Trackpad
The Mac’s Desktop — And How to Use it
Dark Mode — And Night Shift

Desktop Stacks — For Organisation
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Using the Finder - Files, Folders & Apps
The Mac’s Dock — For Most-used Apps
Notification Centre — See What's Going On
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Yor Mac’s Key
Software Apps

We take you through the Mac'’s key software
applications, also known as ‘apps’, step-by-step.
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Safari App — Your Web Browser

Mail App — Send and Receive Email
FaceTime App - Video & Audio Calls
The Music App — Adios, iTunes

TV App — For Movies and Shows
Podcasts App - Listen and Subscribe
Find My - Friends and Gadgets

News App — Stories and Features
Photos App — Manage Your Images
Glossary of Mac and Computing Terms



MOOURGERO " adBO6 - QLTHADP MY

“...get to the heart of your new Apple desktop
or laptop, its macOS Catalina operating system
and its in-built apps and features...”

Can You Run
macOS Catalina? | | E :‘ -

Older Macs cannot be updated to the new MacBook Early 2015 or newer iMac Late 2012 or newer
operating system, so if you want to MacBook Air  Mid 2012 or newer iMac Pro 2017 or newer

upgrade your Mac to macOS Catalina, it MacBook Pro  Mid 2012 or newer Mac Pro 2013 or newer
must be one of the following models:

Mac mini  Late 2012 or newer

) ian@bdmpublications.com ¥ @bdmpubs n BDM Publications @ www.bdmpublications.com

www.bdmpublications.com | 5






You and
Your Mac

~ Newcomers, start here. If you’ve
yet to buy a Mac, or simply want

a recap on what your computer’s
expansion ports are, we start with a
guide to current Mac hardware. We
also show you how to set up your
new or second hand Mac out of the
box, update its operating system

to Catalina and get to grips with its
basic functions.

www.bdmpublications.com | 7
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. The Mac Range
Desktops & Notebooks

Desktop or notebook? Portability or power? Big screen or external monitor?
Buying your first Mac can be bewildering but we're here to help. We bring you
a guide to the current Mac models, their strengths and weaknesses and an
outline of their expansion options.

Desktop Range

Mac m ini The Mac mini is the cheapest of Apple’'s Mac range,

however it's sold without a keyboard, mouse or monitor; you
Apple’s smallest desktop Mac recently enjoyed a major  have to supply these yourself. The current Mac mini, which
refit, but is this small form factor Mac right for you? comes in space grey, has processaors with up to six cores
and faster graphics, providing a significant performance
increase. You can opt for up to 2TB of storage, with fast
MA00RNBRIRORRFTLTOOOE = solid-state drives used across the entire Mac mini range.

Suitability.

Those on a budget or who are
pressed for space. Also, if you
already have a monitor,
keyboard and controller, the Mac
mini is all you need.

Price.

Most expensive:
£1,099, $1,099, 1.249 €
Cheapest model:
£799, $799, 899 €

Ports.
n Power Socket n HDMI port
g Ethernet port B Two USB 3 ports

B Four USB-C ports B 3.5mm headphone port




The Mac Range

Desktop Range e
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iMac

Apple’s popular desktop Mac goes from strength to strength. It's a computer
and a monitor, all in one unit. It's the perfect Mac for the home too.

The iMac is the perfect computer for home and business use. With the computer,
hard drive and screen all in one unit, you only have one thing to plug in. Available in
21-inch or 27-inch versions, all but the cheapest iMac have amazing 4K or 5K
displays, for incredible clarity. The iMac'’s only drawback is it's definitely not suitable if
you need to transport it from A to B regularly, but apart from that, it's great.

Suitability. Ports.

The iMac is ideal for the home and
small office user. Unless you need an n Headphone socket ﬂ Two USB C ports

incredibly powerful computer, there’s E SDXC card reader slot B Ethernet port
bound to be an iMac that's ideal for

your requirements. B Four USB 3 ports B Power socket

Price.

Most expensive:
£2 249, $2.299 2.599 € '—UUIHIH

Cheapest model:
£1,049, $1,099, 1.299 €




™} You and Your Mac |

Notebook Range
MacBook Air

The last refresh brought a host of new
features to the MacBook Air, without
making it any less portable.

Handmade Ceramics
— by Sophie Bland

The newest MacBook Air is available in three
finishes: space grey, gold and silver. It now
features a Retina screen and the display glass
reaches from edge to edge, omitting the bezel.
This allows for a screen size of 13.3 inches, without
making the notebook itself any larger. It's also
Apple’s cheapest notebook in the current range.

Suitability.

All-day battery life and lightweight portability. A great
choice for those who carry their notebook around a lot.

Price. Ports.

Most expensive: Two USB-C port == -
£1,299, $1,299, 1.499 € B o pars '\F —
Cheapest model: 3.5mm headphone port -

£1,099, $1,099, 1.249 € H




The Mac Range

Notebook Range

MacBook
Pro

The most powerful Mac in
Apple’s notebook range.

The MacBook Pro is Apple’s
high-end notebook model. Although
higher priced than the MacBook
and MacBook Alr, it packs more
iR [potier iss gl s O & = hMAGRNCECAMMNBERRNNNER) ¢ ¢ ) W @
13-inch and 15-inch sizes, and the

higher end models include the new P | e e e o ) o b o ey L .
Touch Bar shown here.

control

Suitability.

Users who need a powerful,
yet portable, Mac. Larger
memory capability. The
MacBook Pro is fast enough
for most graphics, video and
music software.

Price.

Most expensive:
£2,799, $2,799, 3.199 €
Cheapest model:
£1,299, $1,299, 1.499 €

Ports.

n Four USB C ports*
B Headphone socket

* The cheaper 13-inch MacBook Pro models have only two USB C ports
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Pro Desktops

iMac Pro

Apple’s pro-level iMac boasts amazing
power, but a high price too.

The iMac Pro is the same size and shape
as the regular 27-inch iMac but under the
hood it's a very different beast. It's
powered by Xeon processors with up to 18
cores and also boasts a Radeon Pro Vega
graphics processor. It's the most powerful
iMac ever built, by some considerable
margin. However, all that power does
comes at a price. Even the lowest cost
iMac Pro is very expensive, so unless you
really need a lot of processing power, it's
probably not the Mac for you. But if you
use your Mac for a lot of heavy processing
waork, it's ideal. Stylish, powerful and
expandable, the iMac Pro is a landmark in
computer design, and an excellent — if \
expensive — addition to the Mac range.

Suitability.
The amazing power offered by the iMac

Pro makes it ideal for video editors, 3D Headphone socket H Four USB C ports
artists, graphics renderers and music
studios. It's not cheap, but you're g SDXC card reader slot B Ethernet port

Ports.

getting a lot of Mac for your money. B Four USB 3 ports B Bewer sxolal

Price.

Most expensive (custom built):
£13,449, $14,499, 16.899 €
Cheapest model:

£4,899, $4,999, 5.499 €




Pro Desktops

Mac Pro

Apple abandoned the unpopular ‘drum’ design for a new,

smaller tower system. It's the most powerful Mac ever built!

The latest Mac Pro is the most powerful Mac ever built. Based on a
tower design but much smaller than the last Mac Pro Tower, this one

offers up to 28 cores of processing power, eight PCI Express

expansion slots, an option for Radeon Pro Vega Il Duo graphics and a

huge range of expansion ports. You can configure up to 1.5TB of

DDR4 ECC memory in 12 user-accessible DIMM slots, and up to 4TB

of SSD storage. Naturally, this isn't a Mac for beginners, but for

high-end Mac users, it's the last word in amazing computing power.

The ultimate Mac!

Suitability.

An incredibly powerful computer, but also a very

expensive one. The Mac Pro is really only for pro users.

Price.

The Mac Pro is due for release soon.

Prices are TBA.

‘ The Mac Range
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Ports.
n Headphone socket
B Thunderbolt 3 ports
B Two USB 3 ports
3 Homi port

B Two Ethernet ports
B Power socket

* All Prices correct at the time of print.

Accessorles. There are lots of accessories you can buy for your Mac. Here are some of Apple’s own devices.

Magic Trackpad 2
£149, $129, 169 €

USB SuperDrive
£79, $79, 89 €

Your Ports Explained.

Now you know what the ports on your Mac are called but what do they do?

Here’s a guide to your computer’s various connectivity options.

Audio In: You can use this port to
connect an external audio device to
your Mac. This might be an external
microphone, a CD player, audio
mixer or a musical instrument.

Dual Mics: The Mac's internal
microphones are great for
FaceTime callls, Siri and more. Dual
mics help reduce background noise
by focussing on your voice alone.

Ethernet Port: All current Macs
have built-in Wi-Fi but if you want to
use a cabled connection to your
router instead, use the Ethernet
port and an Ethernet cable.

Headphone Socket: This is a
standard 3.5mm socket for

connecting headphones to your
Mac. Alternatively, connect external
speakers that use a 3.5mm jack.

HDMI Port: This port is used to
connect your Miac mini, Mac Pro or
older notebook Mac to a monitor or
TV, using an HDMI cable. This
connection carries both the sound
and video feeds.

MagSafe: This is your MacBook
Air's charging port. Connect your
power adapter to charge it. You can
also find MagSafe charging ports
on older MacBook Pros.

Power Socket: Obviously, desktop
Macs have no internal batteries so
have to be connected to the mains.

HomePod
£319, $349, 349 €

The iMac uses a kettle lead, the
Mac mini a figure-of-eight cable.

SDXC Card Reader: If your Mac
has an SDXC card reader, you
can plug an SD card, or a
MicroSD card with an adapter,
into it directly. It's great for
transferring photos to your Mac.

Thunderbolt 2: Thunderbolt 2 is a
fast, versatile connectivity port
you can use to connect all sorts
of peripherals. You can even use
it as a video-out port for an
external display.

USB 3: USB 3 ports are ideal for
devices such as printers and hard
drives. They're backwards

AirPort Express
£99, $99, 109 €

AirPort Extreme
£199, $199, 219 €

compatible, so if your device is
USB 2, you can still use itin a
USB 3 port.

USB-C, Thunderbolt 3:

The most recent Mac notebooks
use Thunderbolt 3 (compatible
with USB-C devices) exclusively,
even for charging. If you have
older USB peripherals, you need
an adapter or dock.
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First Time User?
Start Reading Here

If you've never used a Mac before, read these tips first. We show you; how to
use this guide, basic tasks such as switching on and off, waking it from Sleep
Mode, finding out what Mac and version of macOS you have, and much more.

A Guide to the Guide: How to Use This Book

@& System Preferences Edit View Window e B ¢ % 1 VO M 3 = @) 0xE 2 &= Tue306pm

vvvvvv

Following Links

In this guide, we sometimes ask you to follow a chain of links,
separated with Chevrons (>). For example, to get to this page,
open System Preferences, click on the Security & Privacy icon
and then click on the Firewall tab. We might express this in the
book as System Preferences > Security & Privacy > Firewall.
You will then find yourself at the window shown here.

2 Glossary of Mac and
« Computing Terms

‘Going Further weh Your Mac and! ]
ve

We

that

Where that's the case, this glossary shoukd help. Ifyou're confused by a
technical term, take a look; you might justfind the defirtion you need in here.

Glossary of Mac and Computing Terms

In our guides, we try to keep potentially confusing technical jargon
and computing terminoclogy to a bare minimum, but inevitably, you
might come across a word or phrase with which you're not
familiar. That's where our computing glossary comes in. It's found
at the back of this book, and it explains these technical terms, so
if you're stuck, check it out.

o vz

The Mac’s Desktop
And How to Use it

‘The deskiop is at the heart of your Mac. Everything you dotakes place on
the desktop, including opening apps, interacting with files and foiders and
using the Dock. Here we show you how 1o use your desktop, app and folder

Annotations Explained

We often start a tutorial with an annotation; a screen-capture of
the app or feature in question alongside a guide to the various
buttons, icons and links you need to use it. If you find
something unfamiliar when using an app, it's worth checking
our annotation, as it could be explained therein.

T o s vourvic

Launching Apps
‘ And Quitting Them

There are several ways of launching an app on your Mac. You can: use the
Launchpad, which is found in the Dock; you can open a Finder window and
navigate your way 10 the application you wish 1o Use: or you can click on the
Spotlight feature and simply type its name and seiect t from the ist

Using Spotlight

Using Launchpad

Steps and Boxouts

Where necessary, our tutorials are divided into self-contained
sections that teach you different aspects of the app or feature
in question. These tutorials are usually divided into numbered
steps to be followed sequentially. Our boxed tips highlight a
specific function of an app.




[First Time User? -

Learning the basics on Your Mac

.

\

\

Switching Your Mac On
To turn your Mac on, simply press the button with the symbol
shown here. On a Mac notebook, the power button is at the top
right of the keyboard. On a Mac mini, iMac or cylindrical Mac
Pro it's around the back. On an older, tower-style Mac Pro, it's
at the front.

Finder File Edit View Go Window Help
About This Mac

System Preferences...

App Store...

Recent Items | 2
Force Quit Finder X48d

Sleep
Restart...
Shut Down...

~%Q
°%8Q

Lock Screen
Log Out lan Osborne...

Turning Your Mac Off

When you need to turn your Mac off it's important to do so in
the correct sequence, don't just press the Power button (unless
the screen is frozen and nothing else works). Go to the Apple
menu in the top left corner and select Shut Down... Your Mac
will then close your apps and turn itself off.

Awaken Your Mac from Sleep

If you leave your Mac unattended it goes into Sleep Mode to

both conserve energy and protect your privacy. When you try
to use your Mac in Sleep Mode you will see this screen. Enter
your Mac'’s passcode chosen during the initial setup (not your
Apple ID) and then press Enter or click the arrow adjacent to
the text field.

System Preferences

lan Osborne
Force Quit System Preferences X 0:%9
Skeep
Rostart.
Shut Down.

The Magic Mouse

I your Mac came with a Magic Mouse, you might be
wondering where the buttons are. In fact, the whole mouse is a
button, on which you can also perform gestures. To learn more
about using your Magic Mouse go to System Preferences and
open the Mouse pane, here you can also configure it to your
own requirements.

(N *epStore Ect Store Window Help WD ¢ VoM £ = < 00xE 2 = Twedllem O

System Preferences...
App Store. 1opaue.

Recent items >

Force QuitApp Store T 0%D
hhhhhh

~%Q
Log Out an Osbome... Q.

Which Mac and macOS Do You Have?

To find out which Mac model and macQS you're running go to
the Apple menu and select About This Mac. You will see this
window showing the model and OS version alongside
important system information. Checking compatibility with
apps or peripherals is one of the many reasons for accessing
this information.

Siock Dog Madia - Toch Guides snd Guidebooks +]

2N
]
Black Dog Media Master Your Tech  © From Beginner to Expert

Highlights Tech Guides Shop Guidebooks Ultimate Photoshop Subscribe

Scrolling on a Mac

One of the most important ways to interact with your Mac is
scrolling within an onscreen window such as a Safari website, a
document or a photo. To do this on a trackpad place two fingers
on the surface and drag them up, down, left or right. Or if
instead you are using a Magic Mouse, drag a single finger over
the back of the mouse.
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Set Up Your Mac
For the First Time

Setting up your new desktop or notebook Mac for the first time can be a
daunting experience but it's nothing to be afraid of. In this section we take you
through the initial set up process, from switching it on and setting up or logging
in with your Apple ID, all the way to having it ready to use.

Welcome

In just a few steps, you can register and set up your Mac.

Your first step is to choose your territory, that is, where

you live and will be using your Mac. You can scroll the
list of countries up and down to find your own. Click your
country to highlight your choice and then click the arrow
marked Continue.

Select Your Wi-Fi Network

Now choose your Wi-Fi network. Scroll up and down the

list until you find your router’s SSID (service set identifier)
and click on it. Enter the password in the field provided and
move on. The router's SSID and its password should be
supplied with the router.

Written and Spoken Languages

The following languages are commonly used in your region. You can set up your Mac to use these
settings, or customize them individually.

) Fretomed Languages
Engiish (UK)
Input Sources
British
. Dictation
£ Engish (United Kingdom)

Now select your language and input source. The

default ones for your chosen territory are offered, but if
you want to change them, click Customize Settings and set
the language your Mac uses and the keyboard layout to suit
your needs.

Data & Privacy

This icon appears when an Apple feature asks 1o use your personal information.

£

You won't see this with every feature since Apple collects this information only when
needed to enable fence.

Next comes the Data & Privacy screen. You're shown an

icon that appears when an Apple feature collects
information, and needs your permission. There's nothing you
need to do on this screen, just read it for reference and move
on once more.



Transfer Information to This Mac

If you have important information on another Mac or Windows PC, you can transfer it 1o this Mac.
fou can also transfer data from a Time Machine backup or another startup

-

How do you want to transfer your information?

From a Mac, Time Machine backup, or startup disk
From a Windows PC

© Don't transfer any information now

You're invited to transfer information from a Mac or Time

Machine backup, a Windows PC or not at all. To transfer
data from your old computer, choose the correct option and
follow the on screen instructions. Otherwise, choose the last
option to start afresh.

Sign In with Your Apple ID

Sign in to use iCloud, the App Store, and other Apple services,

Set Up Later

AYORIGIC

A message with a verification code has baen sent 1o your other devices running iOS 10/
macOS Sierra or later. Please enter the code to continue.

If you already have an Apple device, a six-figure identifi-

cation number is sent, which you must type now. If it
doesn't arrive for any reason, click the link under the number
fields and follow the instructions. Otherwise, type the numbers
and proceed.

Create a Computer Account

Fill out the following information to create your computer account.

Full name: lan Osborne
Account name: ianosborne
S | —

Hint:

Your account name is based on your Apple ID name but

your password, which unlocks the computer, should be
chosen now. Choose something you can remember and enter
a hint in case you forget. We recommend you agree to both
the checkbox options.

Set Up Your Mac For the First Time

Sign In with Your Apple ID

Sign in to use iCloud, the App Store, and other Apple services.

Set Up Later

O® ®Cn®

Apple ID

Create new Apple ID. Forgot Apple D or password?

Use different Apple IDs for iCloud and Apple media purchases?

B)

”
&/

Back

Now it's time to sign in with your Apple ID. If you already

have an Apple ID, sign in now with your password. If you
don', click the Create New Apple ID link and follow the
on-screen instructions. There’s also a link for if you've forgotten
your Apple ID.

Terms and Conditions

Use of your Mac computer, the macOS software, Game Center and related services Is subject to
these Terms and Conditions. Please read them carefully.

A. macOS Software Licence Agreement

License, Warranty, and other important product information are saved on your system,
bo found in About This Mac. The License s aiso posted at www.apple.comiegal/sia

©)
po

You're shown a screen of Terms and Conditions, which

you can read by clicking More under each entry if you
wish. When you're ready, click the right-pointing arrow at the
foot of the screen to agree. Then click the Agree button on the
pop-up screen.

Express Set Up

You have signed in to your Appie ID “ian.osbome @dsl.pipex.com” for iCloud, the App Stare, and ather Apple services, The
features and settings balow will ba sat Up for You, of yoU €an customize the settings yoursalf.

Learn More

il heips you get things dane st by a1king. You can send 3 massage,
PE  cictate a not, or check tho weather. Sir sends Information fke your
voies input. contacts, and lecation to ADga o process your requests.

Ao Mops s tbr st srces iy st
B Socionscssestons - gins s e o ot

your location.

I i Aol imorove s procuctsand sarices b stowing
(il Rty

Customize Settings

>

On the Express Setup screen, you can set up your Mac

quickly, by allowing predetermined settings to take
effect, for things like Siri and Maps. You can customise these
settings by clicking the link; we suggest you just click
Continue instead.
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Screen Time

Get insights about your screen time and set limits for what you want to manage.

Set Up Later
Weokly Reports
T | e

Downtime and App Limits
|
Ehei i O s

Content & Privacy Restrictions
Restrict settings for contacts, explicit content, purchases
and downloads, and privacy.

Screen Time Passcode

Manage screen time for chidren from your Mac of 105
device, or use a screen time passcode on your child's

device

You now decide whether or not you want to set up

Screen Time. Click Continue to have Screen Time give
you updates on how you're using your Mac, or the Set Up
Later link at the top to leave it be for now. You can activate it
later in System Preferences.

FileVault Disk Encryption

Filevault secures your data by encrypting the contents of your disk and locking your scroen with

Would you like to use FileVault ta encrypt the disk on your Mac?

Turn on FileVault disk encryption
Allow my iCloud account to unlock my disk

Your iCloud account *ian.osborne@dst pinex.com” can be used 1o unlock your disk and reset your password if you
forget it
f you do not want to allow your iCioud account 1o reset your password, you can create a recovery key
and store it in a safe place 1o unlock your disk.

Choose whether to secure your disk with File Vault

Encryption. If you change your mind later, you can go
to System Preferences > Security & Privacy, and click on the
File Vault tab. You can change your File Vault preferences
from there.

Setting Up Your Mac...

Now you wait for your Mac to finish setting up. Be patient.
It might well take a few minutes to sort itself out. The ticks

appear on your screen one by one, and eventually, the Catalina
desktop appears. Your setup is now complete.

All your files and photos in iCloud

Keep the most important things on your Mac safely stored and available everywhere.

E &

Al your files from the Documents folder and the Desktop will sutomatically uplosd
to iCloud Drive and stay up to date on all your devices. This will use 558 KB of
iCloud storage.

Stere photos and videos in iCloud Photos

All your photas and videos from the Photos app will automatically upload to iCloud
Photos and stay up to date on all your devices.

If you accept the option to store all your files in your

iCloud service, documents and data on your Mac’s
desktop and in your Documents folder are synced across all
the Apple devices logged into the same Apple ID. This is
convenient but takes up storage space.

Choose Your Look

nevoem Ny

Select an appearance and see how the Dock, menus, buttons,
and windows adjust depending on which one you choose.

You can change this later by going to System Preferences.

You now decide on how you want your Mac to look. You

can choose Light Mode, Dark Mode or have it swap
between them according to how high the sun is in the sky. This
decision is not permanent; you can change it in System
Preferences later.

< General

Appearance: i - ﬁ

Light Dark Auto
Mcenteolor- O PO OO O @ @
Highlight colour: Blue B

Sidebar icon size: Medium

Automatically hide and show the menu bar

Show scroll bars: ) Automatically based on mouse or trackpad
When scrolling
Aways
Click in the seroll bar to: ) Jump to the next page
Jump to the spot that's clicked

Default web browser; @ Safari 7]

Askto keep changes when closing documents
Close windows when quitting an app.
When slectod, 0pen documents and windows wil nat be restored

Recentitems: | 10 [5) Documents, Apps and Servers

Use font smoothing when available ?

If you change your mind about some of your chosen

options, you can change them in System Preferences. For
example, the Analytics option is in Security & Privacy > Privacy
and the Light or Dark Appearance is found in the General pane.



More Options You Might See

We've shown you the simplest way of setting up your Mac but
there are a few more options you might find.

If you're using a MacBook Pro, there’s an additional step

to register a fingerprint with Touch ID. This is used for
unlocking your Mac and for making purchases with Apple Pay.
Follow the on-screen instructions to register for Touch 1D or
click the link to set it up later.

Help Apple and app developers improve their products and servic

If you don't opt for the Express Setup, you have to set up

a few things separately, such as whether you Enable
Location Services and whether to share analytical data with
Apple and third-party developers. You can change your mind
later if you wish.

Siri is Apple’s digital personal assistant. The feature can

be enabled or disabled, depending on whether you
want to use it. If you use the Express Setup, Siri is turned on
but either way your choice can be changed in System
Preferences later.

‘ Set Up Your Mac For the First Time

Reset to Factory Conditions.

If you acquired your Mac second hand, you might want
to wipe it clean and start again. Just follow this guide.

macOS Utilities

Restore From Time Machine Backup

Reinstall mac0S
o Get Help Online

¢ Disk Utility )
[

First, restart your Mac whilst holding down CMD and R;
keep them held until you see the Apple logo. A window
appears, titled ‘macOS Ultilities’. Select Disk Utility and
click Continue. Select your startup disk (called Macintosh
HD by default) and click Erase.

® DiskUtlity Flle Eait i

On the next screen, the Format pull-down menu should
read APFS if it's available or Mac OS Extended (Journaled)
if it isn’t. Select the appropriate option and click Erase to
wipe your boot drive. When it’s finished, click Done, then
quit Disk Utility (CMD-Q).

Install macOS Catalina

macQOS Catalina

To set up the installation of macOS Catalina, click Continue.

HO)

Continue

Now choose Reinstall macOS and continue. When invited
to install the operating system, do so; you might have to
click on the Wi-Fi icon in the menu bar and rejoin your
wireless network. Agree to T&Cs, select your main drive
and click Install to start afresh.
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Update macOS
10.15: Catalina

You can also use these tips

to upgrade to future macOS

releases, whenever they are
made available.

If your Mac is running an older version of the operating system, you're
probably keen to upgrade to the latest release of macOS, Catalina. Apple has
made this very easy to do. As long as your Mac meets the minimum system
requirements, you can upgrade over the Internet, and it's free.

Edt_Store_Window _Felp CEDE 3 TVOo M I =4 wnld & @ Twiimm O

Y Discover

Apps and Games We Love Right Now
& Arcade
A\ Create

6 macOs Catalina
view
o4 work

® Py \ /
/ Develop

@ Categories

€3 Updates @&

@ CARROT Weather
£14.00

Apps that look great in Dark Mode Move up to Adobe Lightroom

First of all, open the App Store and find the Catalina

operating system. Do a search if it's not immediately
visible on the front page. Click on macOS Catalina to get to the
download page.

Minimum Requirements.

Before you start, you should make sure your Mac is
powerful and recent enough to run macOS 10.15: Catalina.

The system requirements for Catalina are almost identical to
those for its predecessor, Mojave. To upgrade to Catalina, your
Mac must have at least 2GB of memory, be running OS X 10.8
Mountain Lion or later, and have at least 12.5GB of free storage
space: possibly up to 18.5 GB if you're running an operating
system earlier than El Capitan. It must also be one of the
following models. To check, go to the Apple menu and select
About This Mac.

iMac Late 2012 or newer
iMac Pro 2017 or newer
MacBook Early 2015 or newer
MacBook Pro Mid 2012 or newer
MacBook Air Mid 2012 or newer
Mac mini Late 2012 or newer

Mac Pro 2013 or newer

Edit_Store Window _Heip

DED - £ 1 VoM £ = ¢ woxB® 2 = lwedlipn ©

* Discover
& Arcade
jﬁ Create
4 Work
o Play

A Develop

@ Categories
0 Updates @

L [+

Ratings & Reviews
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This app hasn't received enough ratings or reviews to display a summary.

When you get to the Catalina download page, you can

read all about the new OS. When you're ready, click
on Download. It may take some time if you have a slow
Internet connection.

Make a Backup.

I's always a good idea to keep a backup of your important
files, so make sure yours is up to date.

Upgrading the operating system is a big step, so as always,
before making any major change to your computer, it's a good
idea to make a backup of your data. The upgrade is a very
safe process and won’t damage your files by itself but there’s
always the unexpected risk of a drive failure or power cut
during the installation process, which could leave your Mac
crippled. Better safe than sorry!




0S Catalina

File Edit Window

Install macOS Catalina

macOS Catalina

To set up the installation of macOS Catalina, click Continue,

Continue

3 When the installer is fully downloaded, it automatically
launches with this screen. Click Continue if you're ready
to install and if not, quit it and install later.

Update macOS to 10.15: Catalina

AT macOS Catalina File Edit_ Window ¥

Install macO$ Catalina

macQOS Catalina

To continue installing the software, you must agree to the terms of the software licence agreement.

APPLE N
soFTWY AGREEMENT

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT ("LICENSE") CAREFULLY BEFORE USING THE
SOFTWARE. BY USING THE SOFTWARE. YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS

LICENSE IF SCTRONICA YOUR AGREEMENT T0 B&
BOUND BY THE TERMS OF THIS LICENSE BY CLICKING THE "AGREE- BUTTON. IF YOU DO NOT AGREE TO.

IMPORTANT NOTES:

e e me ne ease vase )
A copy of the Licence wil be saved on your system and can be found through
Itis aiso posted at

-
© ©

Disagree Agree

Next step is terms and conditions. You have to click on
Agree to continue. If you don't have time to read them,
there’s a copy available in About This Mac after the installation.

Fiie EQT  Window

Install macOS Catalina

macOS Catalina

macOS Catalina will be installed on the disk “Macintosh HD".

Macintosh HD

Show All Disks.

Install

Next choose the hard drive you want to install Catalina on.
It will probably be your Mac’s own hard drive but you can
install it on an external drive if you wish. Click Install to continue.

Install macOS Catalina

macOS Catalina

macOS$ Catalina will be installed on the disk “Macintosh HD".

Macintosh HD

About 36 minutes remaining

7 The new operating system downloads and installs on
your Mac. When the installation is complete, your Mac
closes down any open apps and restarts.

File Edit Window €1 Fri12:d)

macOS Catalina

Install macOS Catalina

-3 ~ In order to continue installing macOS Catalina
» . youneed to log in as an administrator,
l_. Enter your password 1o allow this:

Username: Hans Grese

S —
cance (T

Macintosh HD

‘Show Al Disks...

© @

Back Install

After entering your admin password, Catalina begins the first
stage of its installation. All you can do now is wait. Make
sure you don't turn off or unplug your Mac during the process.

Storage  Memory  Support  Service

macOS Catalina

Version 10.16

MacBook Pro (Retina, 13-inch, Early 2015)
Processor 2.7 GHz

Memory 2 GB 667 MHz DRAM

Startup Disk Macintosh HD

Graphics Display 64 MB

Serial Number CO2P902HFVHS

System Report... Software Update...

It takes a while but eventually your Mac reboots into
Catalina. You're asked to choose a few options, which
can be changed later, and after that, the setup is complete.
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- Launching Apps
And Quitting Them

There are several ways of launching an app on your Mac. You can: use the
Launchpad, which is found in the Dock; you can open a Finder window and
navigate your way to the application you wish to use; or you can click on the
Spotlight feature and simply type its name and select it from the list.

Using Launchpad

=S s L
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To open the Launchpad, go to the Dock and click on it,

or place four fingers on your trackpad and bring them
together. The screen darkens and your apps are shown as
icons. To launch an app from this screen, click on it. To close
Launchpad, press Esc or click on the desktop.

© O
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You can arrange your apps into folders on Launchpad

too, just like on an iOS Home screen. Just drag one app
onto another and a folder is created. You can click on the
name if you wish to change it and to remove an app from that
folder, drag it off the grey folder area.

PFEFHBFODNROO0OBOO -Nv® =26 HEEEMY

If you have more than one page of apps, move between

them by swiping left and right with two fingers or hold
CMD and use the arrow keys. Click and hold on an app and
an X appears in the top left corner, except for Apple’'s own
apps. Click the ‘X’ to delete an app.

®
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Open and close folders by clicking on and off the folder

icon on the Launchpad screen. You can add new apps
into the folder by simply dragging them onto the folder. You can
also drag apps around the Launchpad window to change the
order in which they're arranged.



Using Spotlight

@ Finder File Edt View Go Window Heip

To launch an app using the Spotlight feature, first click

on the magnifying glass found in the top right corner of
the screen. A window saying ‘Spotlight Search’ pops up. If it's
inconveniently located, you can drag it around the desktop and
move it to wherever you like.

Using the Finder

N\ " lovies
Recents A
[ Documents
A | Desktop

Launching Apps IZ-

Begin to type the name of the app you want to launch and

Spotlight tries to complete it for you. When you see the
name of the application you're trying to open, press Enter and it
launches. To close the Spotlight search window without launching,
or opening, anything, just click anywhere on the screen.

Using the Dock

meo «HNe @ =

You can also launch an app using the Finder. Open a new
Finder window (or use one that's already open) and click on
Applications in the sidebar. All of your Mac's apps are
shown. Find the one you want to use and then double click
on it to launch.

Quitting Apps.

Open apps are shown in the Dock. On the app’s Dock icon,
you can click using the right-hand side of a Magic Mouse or
trackpad (right-click), hold the Control key and click anywhere
(CTRL-click) or click and hold, then click on Quit in the
pop-up window.

You can launch an app from the Dock. If your Dock is hidden,
move your pointer to the foot of the screen to reveal it and click
on the app you wish to use. To find out more about the Dock
and how to customise it with your favourite apps, see our
tutorial later in the book.
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iPhone 11 Pro

Pro cameras. Pro displ

Alternatively, with the app to the fore in Finder, click on its
name in the top left corner and select Quit [app hame] from
the menu; or hold the Command key and press ‘Q’. Just
make sure the app is open on your desktop or you might quit
the wrong application.
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) Get on the Internet
X With Wi-Fi or Ethernet

The Internet is likely one of the reasons you bought your Mac. When you're
online with your notebook or desktop Mac, you can surf the web, send and
receive emails, make Intemnet telephone and video calls, buy apps and media
and more. Here’s a guide to getting online using the Mac’s Wi-Fi connectivity.

Going Online with Your Mac

W) 100%@3 =% Wed1226pm A& Q Q

v ]
Turn Wi-Fi Off

lan Osborne's iPhone

'S
=}

9 ) ) ) ) a)a) B

AzroLtd
BTWi-fi
HP-Print-73-Officejet 6700
NewHomesShop

NRF

TNCAPDFD31B
TNCAPDFD31B-5G
TP-LINK_AP_4C1A

Virgin Media
VYM0111864

& Join Other Network...
Create Network...
Open Network Preferences...

e

PDPDDDDD D

Ensure your Mac is within range of your wireless router.

Click on the Wi-Fi icon in the menu bar as shown, and
look at the list of available Wi-Fi networks. If Wi-Fi is currently
turned off, switch it on using this same icon.

3 T S B % = W) 100%
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Make sure Remember this Network is ticked, so you don’t

have to enter your Wi-Fi password again. Your Mac logs on
to the network and the Wi-Fi icon shows it's made a connection.
If the icon is only partly darkened, your signal strength is weak.

File Edit View Go Window Help o) 100% B3

| Turn Wi-Fi Off

lan Osborne’s iPho
g Azroltd

BTWi-fi

NewHomesShop

_ The Wi-Fi network "TP-LINK_AP_4C1A" requires a
WPA2 password.

You can

near any
network and

Password: |

Show password
Remember this network

Cancel

Find the name of your own Wi-Fi network. If you don't

know it, check your router’s instruction manual. Choose
that network, and if prompted, enter the password. This too
should be in the router manual or on the router.

Using Public
Wi-Fi.

Some high street locations
such as libraries, bars and
restaurants offer free Wi-Fi
to their customers. There
are many different ways
you can access public
Wi-Fi. Some locations may
have an unsecured
connection, some require
you to ask for their Wi-Fi
password, and for others you have to register via their
pop-up website; just open Safari while in such a Wi-Fi
zone and then follow the on-screen instructions that
appear when your Mac connects to the network.




Configuring Your Wi-Fi

@& System Preferonces Edt_View Window Help T 3

Network Name: | TP-LINK AP 4C1A

Automatically join this network

Ask o oin Personal Hotspats.

Advanced...

Open System Preferences from the Apple menu in the

top left corner of the screen or from the Dock and click
on the Network preference pane. Press the Advanced button
and make sure the Wi-Fi tab is open, from the list across the
top of the window.

WIEGN TP ONS  WINS  BO2TX  Prosies Mardware

Preferred Networks:

z

Turn Wi-Fi on or off

WI-Fi MAC Address: d0:a6:37ecibd:el

You can see a list of all the Wi-Fi networks your Mac

has connected to, in order of preference; where two
networks are available, the higher one is used. If you want to
change this order, simply drag and drop them.

‘ Get on the Internet

Going Online with Ethernet.

If you prefer the stability and speed offered by a
cabled, Ethernet connection, here’s how to set this up.

TNCAPD29408
ThelittieQrangeCafe
bs

Bath-QH2S WPAWPAZ Porsonal
FRITZIWLAN R WPAIWPA2 Pers:

WI-FI MAC Address: d0:a6:37:ec:bd:e1

To remove a network from this list, click on it and click

on the minus button below the list. On this window, you
can also make the Mac ask for admin authorisation for
network tasks, using the checkboxes at the bottom.

Once you've set up your router according to the instructions
supplied with the device, getting online using Ethernet is
relatively easy. First of all, you need a cable that looks like
this. There should be at least one supplied with your router.

Plug one end of the cable into your Mac and the other end
into one of the router’s Ethernet ports: it doesn’t matter which
one. If your Mac doesn't have an Ethernet port, you need an
adapter. You can get one online or from an Apple Store.

If your router isn’t close ‘
enough to your Mac to ‘

support a cabled [ J
connection, consider

using Home Plug AV /
instead. This uses your

household electrical [ U

wiring to send data.
Ask at your local [ J
computer store about a

Home Plug AV starter
kit. There are many
different brands of
HomePlug AV devices
to choose from, and as
HomePlug AV is an
industry standard,
they’re all compatible
with each other.

Py
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#== GGesture Controls
» On Your Trackpad

Something we really like about the Mac is the way you can navigate using
gesture controls, just like you do on your phone. These gesture controls
can be performed on a Mac notebook’s trackpad or on the Apple Magic
Trackpad, which is available for desktop Macs.

One of the things that makes the Mac such a pleasure to use is its large and responsive MacBook multi-touch
trackpad or the desktop Mac’s Magic Trackpad. You can use the trackpad in much the same way as you would use
the touchscreen of an iPhone or iPad: to quickly and easily access menus, sort through stacks of pictures or
documents, scroll through documents and to zoom in and out of displayed images. Once you get used to it, you'll find
that it's a very easy and intuitive way of controlling your Mac and that it can do far more than just scrolling.

Secondary Clicking.

Some people like to use a two-button
mouse with their Mac, and this can be handy
for quick access to shortcut menus by
secondary clicking or right-clicking. To set up
two-finger secondary clicking using the
trackpad, select Secondary Click in the Point &

Click pane of Trackpad preferences. To set up
a one finger secondary click zone in the 7 ‘
bottom left or right corner of the trackpad or L ﬂ‘ |
mouse, select Secondary Click in the Point & . .
Click pane of Trackpad preferences, and choose Smgle Click
an option from the pop-up menu. Unlike most other trackpads, the entire MacBook trackpad
works the same as the mouse button; and you can click
anywhere on the track pad to activate apps and select icons.

Multi-touch Gestures.

The MacBook’s advanced trackpad supports the Multi-touch
gestures. They might seem a bit complicated at first but once [ [c]v]e]n]

you get used to them and have had a bit of time to practise, . () ) ) e ) 7 - — - —
they quickly become second nature. Before long you'll
wonder how you ever managed without them. The trick to
using the trackpad properly is to practise using more than
one finger at once. Some gestures use two fingers, whilst
others use three. You need to apply light, firm pressure and
move your fingers smoothly and evenly, all at the same time.
Like we said, it takes a little practice but you quickly become

.proﬁCIelnt at It'. To enable Multi-touch gestures, view Scroll Vertic ally

instructional videos of the gestures and set up various other '

trackpad options, choose Apple > System Preferences and Place two fingers together on the trackpad, then move them up
then click Trackpad. or down. This will scroll vertically up or down the document or

web page you're currently viewing.




Gesture Controls
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Zoom In and Out

Two-finger pinching lets you zoom in or out on PDFs, images,
photos, and other large visual documents or web pages. Place
two fingers on the trackpad, then move them apart to zoom in,
or together to zoom out. The quicker you move your fingers, the
more you'll zoom.

Rotating Images

You can rotate images by placing two fingers on the trackpad
and then turning your hand so that your fingers both move in a
curve. It can be a little awkward on the wrist at first but you'll
soon get used to it. With practice, you wonder how you ever
did without it.
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Access Mission Control

You can access the macOS Mission Control at any time, even
if you've got a full-screen app open. Simply place three fingers
at the bottom of the trackpad and move them quickly upwards
and Mission Control appears.

Force Click

The very latest Apple notebooks feature Force Touch
trackpads, which can tell a soft tap from a hard tap. A hard
tap, or Force Click, can be used to preview a file, drop a pin
in Maps, preview a Safari link, rename a file or folder and
more. It's a concept that should prove very familiar to those
who have used the latest iPhone models.

Switching Between Full-screen Apps

If you've got several apps open full screen at once, you can
quickly flip between them using a gesture. Place three fingers
on the trackpad and quickly slide them to the left or right. This
will scoot the current app aside, revealing the next in line.

System Preferences Edt_View Window Help
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Turn Off Force Click

If you dislike the Force Click gesture, and find it gets in the
way of your workflow, it's easy to turn it off. Open System
Preferences (under the Apple menu in the top left corner),
and go to the Trackpad pane. Under the first tab, Point &
Click, you see a checkbox labelled ‘Force Click and haptic
feedback’. Uncheck it to turn off this feature.
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The Mac’s Desktop
And How to Use it

The desktop is at the heart of your Mac. Everything you do takes place on
the desktop, including opening apps, interacting with files and folders and
using the Dock. Here we show you how to use your desktop, app and folder
windows, the top bar menu, menulets, Trash and other key desktop features.

Menulet: A Menulet is

simply a shortcut or link to
the application or file. That way you
don't have to navigate to it every
time it's needed.

Utilities: Easy access to

Bluetooth and Wi-Fi settings,
volume level, time and date
preferences, some login options and
a handy search utility.

Apple Menu: From the

Apple menu you can log out,
shut down, restart or put the
computer into sleep mode, get
comprehensive information on the
computer’'s hardware and software,
access the System and Dock
preferences, and open items you've
recently closed.

Desktop Wallpaper: Why
have a plain background
when you can spruce it up with your
favourite photo? If you're bored with
the same one day after day, set it to
change regularly. You can even use

your own photos as wallpaper.

Folder Icon: In macOs,

folders work just like their real
world counterparts. You can use
them to store files, data and other
folders. You can call them anything
you like.

Finder Window: The

Finder utility is the central
point for navigation and file
manipulation. Browse and navigate
applications, documents, external
drives and even access other
computers, as long as they're
connected to the same network
(cabled or wireless).

Dock: The Dock offers quick

and easy access to your
favourite applications, documents,
folders and even the trash can. It's
easily edited and customised to
make the most of the way you work.
Apps you currently have open are
always shown in the Dock.

Dock Folder: You can also

put folders in the Dock, as
shown here. The folder can then be
accessed like a Dock app.

Open Application
Window: Application
windows come in all shapes, sizes

and designs. Your Mac’s
applications can be launched from
the Launchpad, the Dock, from
Spotlight or using the Finder.

The Trash: To delete afile,

folder or application, drag it
into here, then right-click on it and
choose ‘Empty Trash’ from the menu.

Customising the Dock.

Go to System Preferences > Dock, where you can configure it to be
on-screen all the time, hide itself when not in use and magnify as you
drag your pointer over it. Experiment and see what you like best.

'IC¥ Finder File Edit View Go Window Helj
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‘ The Mac’s Desktop

Siri. Notifications.

Siri is Apple’s personal i This icon gives you access
digital assistant and to your Notification Center
you can use it on your sidebar. You can swipe it
Mac. Just click on this into and out of view by
icon and a Siri window ) £ swiping across the

opens. See the Siri ) dors right-hand side of the
tutorial for more FaceTime trackpad or by clicking on
information on how to the three-line icon in the
use this feature. top right corner. Again, we
have a full tutorial on this
feature elsewhere.
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Choose New Wallpaper

& Systom Preferences Edit_View Window _Felp.

Desktop &
Screen Saver

To open the Desktop preferences window, click the

Apple menu, select System Preferences, and select the
Desktop & Screen Saver option. Select the genre of picture
required from the left column.

Preferences Edt View Window Help

Deskiop & Screen Saver

BT soen soer
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Click on the image you'd like to use for your wallpaper.

The desktop is updated immediately, so if you're happy
with the selection, just close the window. If you are not happy,
you can easily choose another.

Desktop & Screen Saver

IR scroen saver

Catalina Day

3 If you change your mind about your choice of image
and want to go back to the desktop you were originally
using, just find it among the wallpapers on offer, and click on it
to restore it again.
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Desktop & Screen Saver C

TR sooenseer

Catalina
Dynamic
This deskiop Bicturs changes hraughout the day, based on your acation

v Ap Dynamic Desktop
De: mw Pictur
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Deskiop Pictures.
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Documents.

The first three wallpapers are dynamic; changing in

brightness throughout the day. Location Services must
be on. You can change the dynamic desktop to an ordinary
pic using the pull-down menu.

Use an Image from Your Photos Library.

Desktop & Screen Saver

LISl Screen Saver

- o

Open the desktop preferences: Apple menu > System
Preferences > Desktop & Screen Saver. Select the Photos
item in the directory list, click the small arrow icon to open it.

Desktop & Screen Saver

LIS screen saver

Fill Screen

Deskiop Pictures

es
» @ People
» O Shared

» (3 Albums
v Folders
= Pictures
Documents

Fnlr »
L/

+ Change picture:

Select one of the options within to display any images found.
Click on the required image to set it as your desktop’s

wallpaper, as you can see here.



How to Add Your Own Folder

to the Folders List

< i Desktop & Screen Saver

SR Screen Sover

— o
» Photos —
» Folders

o S
4 e

Click the Apple menu and select System Preferences.
In the System Preferences window, select the Desktop
& Screen Saver option.

< m~
32 Dropbox (Persor
1 Movies
(& Recents
A\ Applications
8 Documens
B Desktop
1© Downloads
) Toam BOM
18 Personal
icloud
© iCloud Drive

Locations
21 lan's MacBook Pro
E) Macintosh HD

Click the '+ icon which is below the directory list on the
left of the window to display a Finder window. Navigate
to the required folder, select it and then press Choose.

Desktop & Screen Saver
B Screen Saver

catolla@shutterstock 146906695
Fill Screen B

3 The required folder should now be visible in the Folders
section of the directory list. Select your favourite image
from the thumbnails, then close the window.

‘ The Mac’s Desktop

Automatically Change the
Desktop Wallpaper.

You can even have your Mac regularly change your
desktop image to something new. Try it, it's fun!

< ] Desktop & Sereen Saver

Screen Saver
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1 Change picture:  Every 30 minu
Random order

Display the desktop preferences: Apple menu > System
Preferences > Desktop & Screen Saver. Toggle the Change
Picture option to show a tick. This opens the choice menu
to the right.

Desktop & Screen Saver

Screen Saver

The wallpaper can be set to change from every five
seconds to once a day. It can even be set to change when
you log in, or when waking the computer from sleep mode,
so you should be able to find something suitable.
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+ Change picture: ~ Every 30 minutes B
Random order

3
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Once you've selected a time option, you can opt to display
the images randomly or simply work through sequentially
by checking or unchecking the Random Order option.
Close the window and enjoy your desktop slide show.
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Dark Mode
- And Night Shift

If your screen'’s too bright, there’s a couple of great desktop features that
can help. Dark Mode inverts the Mac'’s colour scheme, making it much
darker, and Night Shift Mode changes the colour hue, reducing blue light
that can keep you awake if you use your Mac before going to bed.

Dark Mode Night Shift Mode

G# 3§ T ¢ ww m Weiiehon 3 G 0AE

‘System Proforences EGL View Window Help

Buit-in Retina Display

Display  Colour [N

Night Shift automatically shifts the colours of your display to the warmer end of
the colour spectrum after dark. This may help you get a better night's sleep.

Schedule:  Off

Manual:  Turn On Until Tomorrow

Colour Temperature:

AirPlay Display:  Off

Show mirroring options in the menu bar when available

From the Apple menu, open System Preferences. Click From the Apple menu, open System Preferences. Click

on the General pane in the top left corner of the window. on the Display pane and then on the Night Shift talo. From
At the top, under Appearance’, are the Light, Dark, and Auto here you can schedule Night Shift Mode to run from sunrise to
buttons. Dark and Light buttons switch to those modes, and sunset or during custom times; or you can simply turn it on by
Auto lets you schedule the changes. checking the Manual box.

Built-in Re

Dispiy _ Coour N

Night Shift automatically shifts the colours of your display to the warmer end of
the eolour spectrum after dark. This may help you get a better night's sicep.

Schedule: Off B
Manual: & Turn On Until Tomorrow
Colour Temperature:

Less Warm

AirPlay Display: ~ Off B

Show mirroring options in the menu bar when available

With Dark Mode on, the colours are subdued in Finder, With Night Shift Mode enabled, the colour spectrum

windows, the Mac's built-in apps and more. Third-party shifts from blue to yellow. If you use your Mac late at
apps can be updated to take advantage of Dark Mode too. If night, too much blue light can interfere with sleep patterns, so
you find it more comfortable to work on a dark screen, this is using Night Shift Mode when on your Mac close to bedtime

excellent news. can prevent this.




‘ Dark Mode and Desktop Stacks

Desktop Stacks
For Organisation

If your Mac’s desktop regularly gets cluttered with folders, file icons and other
such material that you're currently working on, there’s a solution at hand in
macOS. With a click of your mouse or trackpad, you can organise them into
stacks, grouped according to their file type. Here’s how to do it.

fe_edt [N Go Window Help 7 0 OB 3 2 1) 0%EE = Wed305pm 2 Q © & =

Your Mac’s desktop often fills with files and folders you From the View menu, select the Use Stacks option. Your

know you need regularly but that can mean a very files are stacked on the right-hand side of your desktop,
cluttered workspace. To use Desktop Stacks, first click on the according to their type. For example, images are stacked
desktop to make sure Finder is active, then click on the View together, as are documents. To turn this off again go to View
menu in the top bar. and click Use Stacks.

PZ @ Bk § 2 W) 00D B8 Wed306pm 2 Q O & = i i el © M 2 2 %) 00%0 = Weds06pm & Q O & D

To open a stack, click on it. The items contained in that You can choose how you group your stacks. In View, go to

stack are revealed, allowing you to access and open Group Stacks By and then pick an option. If you use
individual files. To close a stack again, click on the down-pointing finder tags (see later in this book) to identify files from the same
triangle icon that replaced the stack when you clicked to open it. project, for example, grouping by Tags keeps them together.
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About This Mac

The Mac’s Menus
A Key Mac Feature

Menus are an essential part of interacting with your Mac. Whether it's a pull-down
menu accessed by clicking on the top bar of your desktop or a contextual menu
found by right-clicking or CTRL=clicking on a file or folder, you need to know how
to use your menus if you are to get the most out of your Mac and Catalina.

The Apple Menu

‘W ¥ Finder File Edit
About This Macn

View Go Window Help

System Preferences...
App Store...

Recent Items Applications
2 Show "“Affinity Photo" in Finder
") Show “Blu-ray Player Py

... Show “Fa

5 »

X08dD

Force Quit Finder

Sleep
Restart...
Shut Down...

Lock Screen
Log Out lan Osborne...

P EPEP P EPEPEPED i}

(BN B

The Apple menu is found

in the top left corner of
the desktop. To open it, click on
the Apple icon once, then
choose an option. It's always
there, whatever you're doing on
your Mac.

Choose About This Mac

for a window showing you
technical information about your
computer. Tabs at the top of this
window let you delve further,
looking at its Display, Storage
and more; and you can get a full
System Report by clicking a
button too.

3 The System Preferences

option opens the Mac’s

System Preferences, which we
discuss later in this book.

This option opens the App

Store. If updates are
available for your Mac or any of
its apps, this is noted here too.

Hover your pointer over

the Recent Items option to
see the sub-menu showing
apps, documents and servers
you've recently used.

Click here for the Force

Quit window. This window
lists all currently open
applications and notes if any of
them are unresponsive, that is,
they’ve crashed. You can force a
crashed app to quit from here.



7 Click here to put your
Mac into Sleep Mode.
This saves energy and
password-protects your Mac
while you're away from your
keyboard.

Click here to restart

your Mac. This is useful
if you've installed new
software or your Mac isn't
behaving as it should.

Click to shut down
your Mag, that is,
switch it off.

Lock screen brings up

your password screen.
You have to enter your
password to continue to use
your Mac. It's useful if you're
leaving your Mac for a while
and don't want anyone
snooping on it.

Click here to log

yourself out but not
shut down your Mac. This is
only really useful if you have
more than one user account
on your Mac. You can then log
out so another user can log in.

‘ The Mac’s Menus

By hovering over the

Recent Items option,
you get this sub-menu. This
is a list of the applications
you've recently used. Click
on one of them to open it. It's
a great way of going back to
a recently used application.

These are the

documents you've
recently used. If you need to
open one again, this menu is
a quick and easy way to do
so without having to go
through Finder.

Servers you've recently

accessed on your
wireless or Ethernet network
appear here. We've
accessed quite a few
servers here. To open one
again, simply click on it in
the menu. If you never use
external servers, you can
ignore this menu item.

Click here to

completely clear the
entire Recent Items
sub-menu and start afresh
with a clean slate.
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Files and folders have a Contextual Menu that you can access
by right-clicking or CTRL-clicking on the item. This menu gives
you a range of options, including rename the file, move it to
trash, duplicate or copy it, share it using the macQOS Share
options discussed later in the book and more. The Get Info
option brings up a useful information window.

@ WMessages LI £t View Buddies Window Help
New Message =N
Quick Look

Close Window aw
Delete Conversation... ®a
©Open Conversation in Separate Window

Import from iPhone or iPad

Application Menus
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Each application has its own unique set of menus located next
to the Apple menu. They will change when an application is
active and will revert back to the Finder menu when no apps
are active. Each is clearly labelled to make it easier. We'll add
specific details for application menus when we look into the

applications themselves later.

Right-clicking and CTRL-clicking.

Mac mice and trackpads only have one button, so how do you make a right-click? It's actually easier than you think.

lan Osborne
Appie 0, iGioud, Medie & Agp Store

&  Dock M

20A

Systom Preferances

Your Magic Mouse or Trackpad doesn'’t have two buttons,

but you can still secondary-click by holding the Control
(CTRL) key and clicking your mouse or trackpad. Alternatively,
enable right-clicking. Go to Apple menu > System Preferences
> Mouse/Trackpad, depending on which you're using.

Trackped

Scroll& Zoom _ Wore Gestures

Look up & data detectors.
Force Giick with ona finger ~

Tracking speed

Lot Medum Fum  Siow

Silent clicking

Sat Up Bluetooth Trackpad

2 Click the checkbox for Secondary Click. There are also
a few other options here such as click weighting. With
Secondary Click activated, clicking on the right side of a
Magic Mouse or with two fingers on a Magic Trackpad is the

equivalent of right-clicking on a two button mouse.
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. Using the Finder
Files, Folders & Apps

As the Finder underpins everything you do in macQS, it pays to familiarise
yourself with its features and functions. Here we show you how to use a Finder
window, including a guide to its navigation controls, viewing options and also
how to customise the window and get to grips with its advanced features.

Com ponents of the Finder Navigation Controls: The chevron buttons found
. ] _ . under the gumdrops in the top left corner of the window
The Finder is an important part of your Mac's Catalina take you forwards or back through your navigation history.

operating system, so pay close attention to the guides
over the next few pages. Lessons learned in this section
serve you well whatever you're doing on your Mac.

View Options: These four buttons let you set-up
how you view the files and folders in Finder; whether as
icons, a list, in columns or as a cover flow which gives you a
much larger visual preview.
Window Control Options: Use the gumdrops to

close or minimise the window or open it in full-screen Item Arrangement List: Click on the button
mode. See the tutorial over the page for more details on how marked Arrange’ to order the contents of the window;
to do this. according to date, alphabetically and more.
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Share Button: The Share button is found in many
places throughout macOS. Here you can highlight a file
or folder and click the button to send it by email, AirDrop etc.

Tags Button: You can tag a file or folder to make it
easier to spot, group it with other documents and folders
and more. An item can have more than one tag.

Search: If you're looking for a specific item, type its
name or contents into the Search field and press Enter.
You can then revise your search if it's still not found.

Displaying a Finder Window

There are several ways of opening a new Finder window
on your Mac’s desktop. Let's take a look at each in turn.

& Finder

Edit View Go Window Help
New Finder Window
New Folder
New Folder with Selection
New Smart Folder
New Tab
Open
Open With
Print
Close Window

©#N
~¥N

8T
80

Using Menus

Click a clear space on the desktop once, open the File menu,
and select New Finder Window. A window then appears.

Shortcut Keys

Click a clear space on the desktop once to make sure you're in
Finder, then press the CMD and N together. A new Finder
window appears.

Using the Dock

If it isn't already displayed, move your mouse cursor to the
bottom of the screen to open the Dock. Click the Finder
Window to create a new window.

Window Controls Options.

The coloured buttons found in the top left comer are used to
resize or minimise the Finder window.

Close

Click once on the red button containing
a cross. This will work with the majority
of windows and applications.

Minimise

Click the orange button containing a *-*
sign. Again this will work with almost all
windows and apps.

Full Screen
Click the green button containing a ‘+
sign. This will expand most windows
to a full screen.

Using the Finder

Sidebar: There are various options on the Finder
window's sidebar. You can open specific folders like
Documents or Downloads, access external drives and more.

File/Folder View: This shows the files and folders
contained in the currently open folder. They're shown in
the format chosen in the View Options (see 3).

Preview: This is a preview of the currently selected file
in the main window. It shows the title, file size and various
details about it. There are options at the foot of the sidebar.

How to Relaunch Finder

If the Finder has crashed or isn’t behaving as it should,
follow this tip to close it like a crashed app and relaunch it.

(BCH Finder File Edit View Go Window Help
About This Mac

System Preferences...
App Store...

Recent Items

Force Quit Finder XOCHD

Sleep
Restart...
Shut Down...

Lock Screen
Log Out lan Osborne...

~#Q
i {e]

If the Finder crashes you can relaunch it like you would a
crashed app. The easiest way to do this is to click on the
desktop to make sure you're in Finder, hold down the Shift
key and click on the Apple menu. The Force Quit option has
become Force Quit Finder. Incidentally you can use this
method to quit any running app. Just click on one of its
windows to bring it to the fore, hold Shift and click on the
Apple menu.

Navigation Controls.

These simple controls allow you to retrace your
steps backwards and forwards.

= Navigate to a

® Previous Page

Click the left hand arrow. To
continue stepping backwards,
repeat step one as many times
as necessary.

Favnritae

Using the Forward Control
If you've moved to a previous page,
this button offers step-by-step
navigation to your original starting
point. Simply click the right-hand
arrow as many times as needed.
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View Options
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View Window Contents as Icons

To display your files and folders as a collection of icons, first
open a Finder window then click the first button on the toolbar,
showing a group of six squares.
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View Window Contents as Lists

With an open Finder window, click the second button on the
toolbar to use a simple but effective list display.
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View Window Contents as Columns

Click the third button on the toolbar to view your files as a
series of columns. It's great for quick navigation and easy
visual identification using a handy image preview column.
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View Window Contents as Gallery View

The Gallery View gives a large preview of the file or folder
that’s currently selected and a scrollable strip of everything
else. Click on one of the files in the strip to see a larger version
of its thumbnail.
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Change the Way Items
are Arranged.

As well as changing the way the items are visually displayed, you
can also change the way they are arranged within the file and folder
view area.

Name: Alphabetical. Displays numbers first, then A-Z.
Kind: This groups each type of item together.

Application: Groups together items according to the
application in which they were created or are opened.

Date Last Opened: Groups according to time and date
they were opened.

Date Added: Displays items in order of when they were
added to the folder.

Date Modified: Displays items in the order they were last
modified or edited.

Date Created: Displays the items according to when they
were created.

Size: Arrange the files according to their size.

Tags: Files are arranged according to tags you've added



More Sidebar Functions.

If your sidebar is getting cluttered, you can show or hide
its listed items by hovering over the title (Favourites,
Devices, Shared, Tags) and clicking the word Show/Hide
that appears as shown. You can also eject external drives,
CDs and disk images from the sidebar, by clicking the
eject icon next to the device or image you wish to remove.
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Using the Finder
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Perform Tasks Within the Finder
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Click on the cog-shaped icon for a drop-down menu.
Here you can do a range of operations, from opening a

file in a specific application to checking the file size via the Get
Info option.

The Finder’s Preview Panel.
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You can also clean up the entire Finder Window,

automatically tidying up and or reorganising the order of
the files according to various criteria such as their name
(alphabetical), date, size and more.

Finder windows have a right-hand sidebar that shows a preview
of the currently selected file from the window. You can turn this
sidebar on and off by going to the View menu and selecting the
Hide/Show Preview option.
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At the foot of the preview sidebar are new options. These
vary according to the type of file you're highlighting in the
main window. For example, an image can be rotated,
annotated or turned into a PDF.
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Full-screen Mode
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You can view a Finder window, and indeed, an

application window, in full-screen mode. Click on the
green Enlarge button in the upper left corner of the window
and it will expand to fill the entire screen. Alternatively, use the
View pull-down menu or press CTRL-CMD-F
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In full-screen mode, the menus usually found at the

top of the Mac desktop are still there, but they'’re
hidden away until you need them. To see them, move the
mouse cursor to the top of the screen and the menu bar
slides into view.
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To exit from full-screen mode back to the usual window

view, bring up the Menu bar and then simply click on the
green button again. The window shrinks to its previous size
and no longer takes up the entire desktop.

Hide Menu Bar.

General Q

F.
Appearance: E - l

Light Dark Auto

Accenteolosr Q @ O OO O O @

Highlight colour: Blue

Sidebar icon size: Medium

[ Automatically hide and show the menu bar ]

Show scroll bars: ) Automatically based on mouse or trackpad
When scrolling
Always

Click in the scroll bar to: o Jump to the next page
Jump to the spot that's clicked

You can hide the menu bar at the top of the screen. Go to System
Preferences > General and check ‘Automatically show and hide the
menu bar’. It's now hidden, but appears when you drag the pointer
to the top of the screen.
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You can also take a window out of full screen mode

using the View pull-down menu at the top of the screen
or by pressing CTRL-CMD-F. You can still close a full-screen
window with the red button (top left).

More Customisations.

General

I=.
Appearance: E - l

Light Dark Auto

Accentcolosr O @ O @O O @ @

Highlight colour: Blue

EET—

Sidebar icon size:

Medium

rr———
Automatically hide and show the menu bar

Show scroll bars: @) Automatically based on mouse or trackpad
When scrolling
Always

Click in the scroll bar to: € Jump to the next page
Jump to the spot that's clicked

Something else you can do in System Preferences > General
is to customise Finder windows. You can change the accent
colour, the highlight colour and the sidebar icon size. Try
each in turn and see how you like it.




Changing the Finder Window’s
Background Colour or Image
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When you're using the Finder’s Icon View, you can

replace the white background with a black one or even a
picture. To begin, with the Finder window in question open,
select Show View Options from the View menu or press CMD-J.
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The window's Info window opens. Towards the bottom, you

can see options listed under the header ‘Background'.
Select ‘Colour’ and click on the white square. You can now use
the various options to change the background colour.

Applications

101118 seieciod, 61.65 08 svaiable

Select ‘Picture’ and then drag an image into the box to

the right of the background options to get a pictorial
background. Alternatively, click on the box and then navigate to
the picture you want to use through the Finder.

‘ Using the Finder

Tabs and Tags.

You can use Window tabs and Finder tags to help keep
you and your Mac organised and accessible.
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With a Finder window open, press CMD-T, or select New Tab
in the File menu to open another tab. Click on tabs to switch
between them, and click the ‘X’ in the left-hand side of a tab
to close it. You can drag files and folders between tabs.
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You can open tabs this way in many applications. So, for
example, if you need two Maps windows open at once, you
can open them in tabs instead of separate windows. To
gather separate windows into one, in the Windows menu,
select Merge All.

Photos for Dasktop

- rene

© Team BOM

Kievs

& iCloud Drive. © Purple

Locstions 10210858 @ Oreen
2 ehe

1 lan's MacBook Pro G i

© Gray
Z) Macintosh HD Yellow

0 o Nawe f E o8uo
3 Show AL,
2] oigial Media i
® Netvo 63017 jp MG1095jpeg  IMG1104jpeg  IMG_1167png

Toge
® Gray

© Purple ) H e
i L

MG_4296.ipeg  IMG.4900jpeg  Shutterstock.738
65503j0eg

40114 dalected, 29.22 GB avaiable

You can label files and folders with tags; highlight them in
Finder and use the Tags icon in the window’s toolbar, as
shown. A file can have more than one tag. You can then
click a coloured tag in the sidebar and see all files labelled
with that tag in the window.
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The Mac’s Dock
Qe For Most-used Apps

The Dock is a great way of gaining quick and easy access to all of your most
used applications, documents and folders. It is completely customisable, so over
time, you can adapt it to best fit your needs. You can keep it on the screen at all
times or have it hidden until you need it too. Here's how to customise and use it.

Accessing Your Applications from the Dock

| Launchpad |

Add or Remove an Application

To add an app, first click the spaceship icon at the left-hand
side of the Dock to bring up Launchpad, then click and drag
the item you want onto the Dock. To remove it, just drag it out.

=
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Open an Application

To open an application that's in your Dock, simply drag the
mouse pointer onto the Dock and click on its icon. Notice that
the app icon slightly bounces as the application opens before
the main app opens.

Move an Application

To move an item to a new location in the Dock, click and drag
to the required position. As you move the item the adjacent
applications will move aside to indicate the final position.

Ry < 3o
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Recently Used Applications

In Catalina, applications you've recently used are shown in the
right-hand side of the Dock, from where they can be used like
any other Dock app. Apps that are permanently in the Dock
aren't shown here.
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Adding and Removing Stacks

You can add, remove and move folders in your Dock, in the
same way you do with apps. These sit to the right of the
Dock’s second divider and are called Stacks.
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Accessing Stacks

To access the files and folders within a Stack, click on it to
display the contents. Clicking on a document or image opens it
with an appropriate application, and clicking on a folder opens
itin Finder.

Sort by
+ Name

Date Added
Date Modified
Date Created
Kind
Display as
Folder

_  Stack

View content as
Fan
Grid
List
v Automatic

Options
Open “Utilities"”

Viewing Options

Right-click or CTRL-click on a Stack for a pop-up menu with a

range of options. You can show your files as a Stack (a pile of

files) or as a folder. You can also choose how they're displayed
when you click the Stack.

The Bin.

The Bin icon is located at the far right of the Dock and
can be filled and emptied just like a real rubbish bin.

You can delete a file, folder or app by dragging it into the Bin
on the right-hand side of the Dock. Alternatively, right-click or
Ctrl-click on it, and select Move to Bin from the contextual
menu that appears.

Empty Bin

To retrieve a file from Bin, click on the Bin icon in the Dock to
open it in Finder, then drag the file out of the Bin window. To
empty Bin, right-click on it and choose ‘Empty Bin’, or in the
Bin window, click on the Empty button (top right).

Customising the Dock.

You can customise your Dock in System Preferences from
the Apple menu and selecting Dock. From here, you can
place the Dock on the right, left or bottom of the screen,
opt to show and hide it, change its size, change its
maghnification, choose a minimisation effect and more.

Size:
small
Magnification:
Min
Position on screen:
Left Bottom Right
Minimise windows using:  Genie effect B
Prefer tabs when opening documents:  In Full Screen Only B
Double-click a window's title bar o minimise [
Minimise windows into application icon
Animate opening applications
Automatically hide and show the Dock
Show indicators for open applications
Show recent applications in Dock
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® Notification Centre
See What's Going On

The Notification Centre gathers together all your important updates, notifications
and everything else you need to know, all in one place. You can configure it fo
suit your needs, and it also provides on-screen reminders and alerts so you'll
never miss a thing. Here’s how to access and use it in macOS Catalina.

Accessing Notification Centre

Responding to Notifications

Edt_ View Go Window Help 3 7 O B i % @) 0Bl B Wed6lipm 2 Q © E

20:00 | Brighton and Hove Albion v Aston Vila
Ames Stagun

Click the icon showing three horizontal lines preceded

by bullet points, which is found on the far right-hand side
of the Apple menu bar at the top of the screen. Click on the
Notifications tab at the top to see your notifications.
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lanOsborne 031072019
Atachment: 1 File

Clicking on any notification in Notification Centre takes

you to its app. For example, if the notification is a new
message, you're taken to Messages where you can type your
response. To close a naotification, click the cross.

Alternatively, use a two fingered right-to-left swipe on a

trackpad. This works with a Magic Trackpad (shown
here) or a Mac notebook’s built-in trackpad, but you must
swipe at the extreme right side of the trackpad.
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Notifications

DO NOT DISTURB

Today [>)

N NEWS 15:31

To turn off all on-screen alerts, go to the Notifications panel,

scroll down to the Do Not Disturto switch to mute notifications
for the rest of the day. Alternatively hold Alt and click on the
Notifications icon in the menu bar. When muted this icon is greyed.
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To open the Notification Centre Settings pane, either

open the Apple menu and select System Preferences or
click on System Preferences in the Dock. You can also find the
Notifications preferences via the icon in the top right corner.

[ ] < i Notifications Q

Notification Centre shows your alerts in the upper-right comer of your screen, without interrupting what
you're doing. Show and hide Notification Centre by clicking its icon i the menu bar.

Do Not Disturb @) Alow Netifications from Alfred 4

@) oovordma Afred 4 alert style:

Books.

E ‘Camncav »

Clean Drive
0 Badges, Sounds, Aler 9 show notifications on lock screen
@ Dropbox Show notification preview = always
Badges, Sounds, Ale 9 Show in Notification Centre
‘E"'f‘wy Sav‘af . Badge app icon
Play sound for notifications

o FaceTime
N\ Badaes. Sounds. Bamners

Notification Centre sort order: ~ Recents B

3 In the Notifications Settings pane you'll see a list of your

apps. You can select which ones you want to appear in

Notification Center here. Click on an app to show its options in
the panel on the right-hand side, as shown.
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Notifications

Ntifications. Q

Intre shows your alerts in the upper-right corner of your screen, without interrupling what

how and hide Notification Centre by clicking its icon in the menu bar. SLlews jsad

oNN
‘Trump told sources he couldn

t Distur @) Allow Notifications from Calendar phone call with Speaker Pelosi
: drive for impeachmant
vord minl Calendar alert style:
130
P
There's a new app on Setapp!
Check out what BusyContac s has \]J\
wofter.
None Banners =
i ~ NEWS )
BBC Science Focus Magazine
Show notifications on lock screan Al created to transiate babies’ cries
x Show notification praview _ ahways
g g = - ~ NEWS 1w
Show in Notification Centre.
Save A s o
{ o s 8 Bacge app UK Parfiament resumes ami raucous scenes aflar
Play sound for notifications Prime Minister Borls Johnson's unlawlul
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~ NEWS 10:50

tre sort order:  Recents 2 ?

All natifications appear in the Notification Centre sidebar

pane regardless of the option you choose here. You can
select different Alert Style settings for different apps, so some
are shown as banners, some as alerts and some not at all.

Notification Centre

Notification Gentre shows your alerts in the upper-right corner of your screen, without interrupting what
you're doing. Show and hide Notification Centre by clicking its icon in the menu bar.

Do Not Disturb
@ 1Password mini
ges, Sounds, Aler

o Afred 4
P Sk Turn on Do Not Disturb:
o Eoo’ks ) From: 22:00 ¢ to: 07:00 &
! " When the display is sleeping
@ cf‘f"d“\’ i alire When the screen s locked
) ' When mirroring to TVs and projectors

Turn on Do Not Disturb in

Notification Centra

0 Clean Drive
dges, Scunds, Alerts When Do Not Disturb is turned on:
@ Dropbox Allow calls from everyone

Er S:
sice, Seuns,Sonne
@

Notification Centre sort order: Recents

Allow repeated calls

Alternatively, open the Notification Centre as explained

on the previous page and click on the cog icon in the
bottom right corner of the Notifications panel. The preference
pane for Notification Centre is opened straight away.

® < Er Notifications. Q

Notification Centre shows your alerts in the upper-right corner of your screen, without interrupting what
you're doing. Show and hide Notification Centre by clicking its icon in the menu bar.

Do Not Distirb @) Allow Notifications from Calendar

@ Password mini Calendar alert style:

a2 Alfred 4
Books

& - None Banners
Calendar Banners appear in the upper-right corner and go away

automatically. Alerts stay on screen untildismissed.

Clean Drive
Badges, Sounds, Alerts Show notifications on lock screen

@ Dropbox Show notification preview always B
Badges, Saunds; Alarts Show in Notification Centre

Energy Saver Badge app icon

Play sound for notifications

CV| FaceTime
\ _Badaes. Sounds. Banners

Notification Centre sort order: Recents ?

For Alert Style, select Banners and they appear briefly
on-screen and disappear. For Alerts the notification
remains on the screen until it's actioned or manually dismissed.

None turns off the app’s notifications.

you're doing. Show and hide Notification Centre by clicking its icon in the menu bar.

Do Not Disturb () Allow Notifications from Calendar

@ 1Pa{sswt:rd ’“i"ir‘ Calendar alert style:

‘ Alfred 4
Badges, Sounds, Banners

Books >
@ saiges. sounss, samers None Banners =

Calendar

Banners appear in the upper-right corner

go away

automatically. Alerts stay on screen until
Clean Drive .
Badges, Sounds, Alerts Show natifications on lock screen
Dropbox Show notification preview  always
Badges, Sounds, Alerts Show in Notification Centre
Energy Saver Badge app icon
Badges, Sounds, Banners

Play sound for notifications

C*q FaceTime
N Badaes. Sounds. Banners

Notification Centre sort order v Recents
Recents by App

Manually by App

Using the pull-down menu, you can change the order in

which Notification Centre displays its notifications. Order
them manually by app and then you can drag the apps in the
left-hand window into a preferred order.
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The Spotlight Feature
Search Your Mac

Spotlight Search is Apple’s unique and ultra-powerful search system that
can find almost anything on your Mac. There’s a whole raft of great features,
making it a really powerful and useful tool that's integrated into the apps that
you use every day. Here’s how to get the most from the Spotlight feature.

Using Spotlight’s Features

Edit_View Go  Window Help FEFT OO T ) K B Wed623pm 2 4 O &L F

To start using Spotlight, press CMD and the space bar, Start typing your search query into Spotlight and

or click the magnifying glass in the top menu, and the immediately answers appear, with suggestions based on
Spotlight Search window appears. In Catalina, unlike older the contents of your computer as well as other sources. This
versions of Spotlight, you can drag this window to wherever may mean you only have to type a few letters of your search
you want on the screen; it's not fixed in position. term to find what you're looking for.

¥ 4506 kilometres

Spotlight can do instant unit conversions for you. For It works in a similar way with distances and lengths,

example, if you want to convert from imperial to metric which Spotlight can instantly convert into other units. For
weights (or vice versa) you just type in the number and a type example, if you type a distance in miles it instantly shows what
of unit, such as kilograms or pounds and Spotlight instantly it is in kilometres, metres, yards, feet and inches. You can even

converts into other commonly used units. convert parsecs into light years.




¥  80.44 British pounds

Spotlight can do some currency conversions. Type in a

number and currency unit, such as dollars or pounds,
and Spotlight gives you the equivalent value in a range of
currencies at the current market value.

Dippiu Htalian Bottega

If you're looking for local businesses or sites of

interest, simply type the name into Spotlight and you'll
quickly find what you're looking for, complete with a link to
the Maps app and the option of travel directions from your
current location.

Summer Holidays 07 2.jpg
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Spotlight is also closely integrated into the core macOS

apps, such as Photos. Start typing in your search term,
like the title of a particular image or photo album in your Photos
app, and Spotlight quickly locates it and takes you straight to it.

41 singapore

P PODDDD W -

For more conventional searches, Spotlight pulls its
information from a wide range of sources, such as
Wikipedia and documents it finds on your Mac. Search results
are listed by category down the left side of the search window.

Alyssa Falcon
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You can find people with Spotlight too. Start typing the

name of someone you know, and Spotlight quickly finds
that person in your Contacts list and displays their contact
details in the results window. Things like chat threads,
Facebook comments and emails are also listed.

He Can Only Hold Her

Spotlight can find music by searching through your iTunes

collection to find albums, tracks and artists. Type a band
name, a track name or even the name of a band member.
Recordings with that name or by that band or person are shown.
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Setting

Up Email

For the Mail App

With email, you can send mails and attachments anywhere in the world, at the
push of a button. It's there instantly too. Here we take a look at what email is,
how you can get yourself an email address and how you can use your email
accounts on your Mac, with Apple’s bundled email client, the Mail app.

Setting Up Your |CIoud Email

@& System Preferences Edit_View Window Help
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If you set up your Apple ID during your Mac’s initial

setup, or if you signed in with an existing Apple ID, your
iCloud email account is already in place. But if not, or if you
want to add another iCloud email account to your Mail client,
follow these instructions.

Inbox (42,115 messages)

rafts v Fisgged v

Sign in to iCloud with your Apple ID.
Don't have an Apple 107 You can create one for free.
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3 Now enter your Apple ID. This is the Apple ID and
password you probably chose when you initially set up
your Mac. When you have confirmed your details you can then
click on the Sign In button to take you to the next step.
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Open the Mail application from the Dock and then under
the Mail drop-down menu found in the left of the menu
bar, click on the Add Account... link. From the pop-up menu

that appears, select the iCloud link and then click on the
Continue button.
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On the next screen, click on Add Account and your

iCloud account is added to the Mail app, for you to use
on your Mac. Your iCloud email can be your sole email account
or you can use it in Mail or alongside others if you wish.
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port > How to Use Email with Mail Clients

How do | use Virgin Media email with other
mail clients?

Rz Feedback

To configure your Mac to access your email account from

your Internet service provider, you need your email
address, your password to access your email account, and POP
or IMAP (incoming) and SMTP (outgoing) server addresses.
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3 When you first open Mail you're prompted to set up your
first email account. If you've previously used Mail or set
up another account, you can add further new accounts by
going to the File menu and selecting Add Account.

Setting Up Email

macOS Catalina includes a sophisticated email program,

simply called Mail. You can find it on the Dock, as it's
there by default. The Mail App’s icon looks like a postage stamp
showing an eagle. Click on this icon to open the Mail app.
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Sign in

You're now asked to enter your full name (this appears in

your own, and other people’s, contact lists), your email
address and your password (both supplied by your email
service provider). Make sure you type them in correctly.
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You're asked for the incoming mail server address. You

should have been given an address when you signed up
for your account. Type it in the box marked Incoming Mail
Server. You can add a description if you want and when you
have it all correct, click on Continue.
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You're asked for the SMTP or outgoing mail server

address. Type it where it says Outgoing Mail Server.
Check the Use Only This Server box and if your email service
requires it, also check the Use Authentication box. Type in your
username and password, then click Continue.
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Your Mac’s
Key Software
Apps

One of the best things about your
Mac and macOS Catalina is the
bundled applications, or ‘apps’,

that come with it. There’s an app for
almost everything, and they’re great
fun to use. In this section, we take a
look at the Mac’s key apps and show
you how they work. Look out for
their advanced features too.
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Safari App
Your Web Browser

Safari is your gateway to the Internet, so it's important that you familiarise
yourself with the browser’s interface before you begin your online adventure.

Navigation Controls:

These two arrow control
buttons enable you to move back
and forth between current and
previously viewed web pages.

Toolbar Buttons: These

buttons give you access to
various Safari features. You can add
or remove buttons by right-clicking or
CTRL-clicking on the toolbar and
selecting Customize Toolbar. See the
section on Customising the Sierra
Finder for more information.

URL Bar: Enter the website

address of your choice or a
search term that you wish to look up
into this bar, then tap the Return key.

Reload Page: Sometimes,

if a web page fails to load
properly, you can fix the problem by
clicking on this button and reloading
the page.

Share Button: Click on this
button to see your options for
sharing the page you're viewing

using email or social media networks,

including adding the page to your
reading list.

Show Open Pages: Click

on this button to view all web
pages you currently have open in the
Safari browser, on both your Mac and
other devices signed into your iCloud.

7 Safari Tabs: When you're
browsing the Internet and you
want to have several pages open at
once, you can view each of them in
their own separate tabs.

Add a New Tab: Clicking

this button will open a new
blank tab, which is then accessible
by clicking on the tab and entering a
search parameter or a URL web
address in the URL bar.

Sidebar: This optional display

area is opened and closed by
clicking on the sidebar button in the
toolbar, next to the Navigation Controls.
It's updated in real-time.

Bookmarks: Click on this

button in the sidebar to see
your bookmarks list, with your
favourite web pages and sites, which
can be visited by clicking the link.

Reading List: From here

you can view all the pages you
have added while browsing, using
the Add to the Reading List button.

Edit Bookmarks:

Previous versions of Safari
had an Edit button on the left panel.
This has now been removed but you
can still go to the Bookmarks menu
and select Edit Bookmarks.

Main Window: This is

where the web page you're
viewing is displayed. You can scroll
up and down by using the scroll
function on your mouse.

Links: Click on a web link to

be taken to another page. Web
links can be text, which is usually
underlined, or a picture as seen here.
When you've moved to a new page,
you can return using the Back button
(see entry ‘1’, on Navigation Controls).

1
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Set New Home Page

Display Status Bar

ﬂ 1 CU M File Edit View History Bookmarks Develop Window Help

About Safari
Safari Extensions...

P E 1O

bdmpublications.com
Preferences... s
Settings for This Website...

. Dog Media

Hide Safari ®H
Hide Others
Show All

Black Dog Media - Tech Gu|

Master You

Clear History...

uides Shop Guidebooks Ultimate Photoshop Subscribe
Quit Safari

Open a new Safari window and navigate to the web page

that you want Safari to load each time you launch the
app. Click the Safari menu (top left corner), then select
Preferences to display Safari’s preferences dialog box.

AutoFill Passwords Search Security Privacy Websites Extensions Advanced
Safari opens with: A new window
New windows open with: Empty Page
New tabs open with: _Empty Page
Homepage: Htips:/ww.google.com/

Set to Current Page

Remove history items:  After one year

Favourites shows: ¥ Favourites

| of of )

Top Sites shows: 12 sites

File download location: e Dowrloads

we

Remove download list items: _After one day

Open “safe" files after downloading
“Safe” filas inelude movies, picturas,
sounds, PDF and text docs i

archives.

Ensure the General tab is selected and press the Set to

Current Page button. A small window may pop up
requiring confirmation; press Change Homepage to continue.
The required page address now appears in the text box above.
['s now your default home page.

Using Links.

# 3 1

® Safari File Edit IS History Bookmarks Develop Window Help

 Always Show Toolbar in Full Scree

Customise Toolbar...

e e & bdmpublications.com
Show Favourites Bar %8 2
®m N Hide Tab Bar Black Dog Media - Tech Guides and Guidebooks
Show Status Bar %/
ﬁ Master Your Tech
Show Sidebar L
Show Bookmarks Sidebar ~®1

Show Reading List Sidebar ~§%2

Show Reader T #R
Show Tab Overview R\
L

Ultimate Photoshop Subscribe

Show Downloads

Stop %
Reload Page #R

Reload Without Content Blockers
Reload With Flash

Actual Size

Zoom In 8+

Zoom Out
Text Encoding
Clean Up With The
Healing Brush Tools

Ensure a Safari window is open and active, i.e. the

window controls in the top left are the usual colours, and
not coloured grey. Click the View menu and select the Show
Status Bar option, which is found near the top of the menu.

9 Tips for Taking Better Photos

Many of these tips cover shooting techniques, others may sin
be advice about equipment and understanding a little more
Open “https://bdmpublications.com/clean-images-healing-brush/* in a new tab

You should now see a grey strip along the lower part of

the window. If you hover the mouse over a link, the
status bar tells you exactly where the link is headed. This is
very useful if you suspect the link takes you somewhere you
don’t want o go.

You navigate the worldwide web in Safari by using hyperlinks or simply ‘links’. Clicking on one takes you to a new page.

T399

Learn to do more with your iPhone, iPad, Mac, Watch & TV
with our info-packed Apple guides!
Step-by-step guides and tuterials for [Phone, iPad, Mac and More
No mre searching online for the answers you need; just reach in to your
pocket
Easy-to-understand, fully illustrated content, wrip”. a 1
5] gigital - Single

Quickly improve your understanding of 108

le
App‘NJ}G!\ZINE

BDM's Essential AppleUser Magazine br Download on the

ntachcai e o your o .’ App Stor®
11/Pro/Max «oee: s !
Series 5

It's time to upgrade!

Alink in Safari can be a piece of underlined text, a picture or a
button, or simply an area of the screen. Drag your mouse pointer
across Safari. When it's over a link, the pointer turns into a hand.
Click there to open the linked page in your browser.

Open Link in New Tab
Open Link in New Window

Download Linked File
Download Linked File As...
Add Link to Bookmarks...

Add Link to Reading List =
Copy Link g
Share » S

Services >

If you don’t want to navigate away from the page that you're
currently on, right-click or Ctrl-click on the link and from the pop-up
menu, choose Open in New Tab or Open in New Window. You
can then look at the new page without closing the old one.



Display Tab Bar

Add Tools to the Toolbar

Safari File Edit BUETM History Bookmarks Develop

+ Always Show Toolbar in Full Screen
Customise Toolbar...
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To toggle Safari's handy Tab bar on and off, open a Safari

window and click View in the menu bar at the top of the
screen. Select the Show Tab Bar option. Alternatively, you can
use the keyboard shortcut: simply press CMD-Shift-T.

i G DR

&
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gine Vol 7 - BDM Tech Guide Books

| Apple User Magazine Vol

nore with your iPhone, iPad, Mac, Wa
-packed Apple guides!

p guides and tutorials for iPhone, iPad, Mac and More
rching online for the answers you need; just reach in to your

Your current page should now have a tab marker just

below the bookmarks bar, as shown in the screen
above. To add a new tab, click the '+’ sign at the right of the
Tab Bar. If you want to hide the Tab Bar again, simply repeat
step 1 and it will disappear.

ari  File Edit

\/C"M History Bookmarks Develop Window Help

v Always Show Toolbar in Full Screen
Customise Toolbar...

Show Favourites Bar
Hide Tab Bar
Show Status Bar */

Show Sidebar
Show Bookmarks Sidebar
Show Reading List Sidebar
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Show Reader
Show Tab Overview
Show Downloads

Stop 8.
Reload Page #R
Reload Without Content Blockers

Laartal o1

Right-click or CMD-click on the toolbar and select Customise

Toolbar; or click the View menu and select the option from
there. A window slides down. To add a button to the toolbar, simply
drag it from the selection in the window onto the Toolbar.

] ] T—
@ \_| = & bampublications.com ciiiliofe u
W Fssential Apple Usar Magazine Vol 7 - BOM Tech Guids Books
Drag your favourite items into the toolbar...
<[> O [u] o i & 0]
Back/Forward iCloud Tabs. Share Show/Exit Top Sites. Home History
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Sidevar Bookmarks AutcFill zoom Mail Website print
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... or drag the default set into the toolbar.
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Sidebar y y Address and Search Share  Show/Exit Tab Overview
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Repeat this with as many tools as you need. When you're

finished, click Done. To remove a tool from the toolbar,
hold the CMD key and drag it off; it disappears in a puff of
smoke. To reset the tools to how they were originally, drag the
default set of tools onto the Toolbar.

Tailor Site Settings and Block Auto-play Videos.

If you want to customise your Safari window’s Toolbar, there are a variety of useful tools that can be added.

File Edit

About Safari
Safari Extensions...

View History Bookmarks Develop Window Help

Preferences...

B
[

Clear History...

Services

Hide Safari
Hide Others
Show All

Quit Safari
AMNANCNZTAE

You can tailor specific settings like the zoom level, location
services, content blockers and more for individual websites. These
settings are then applied whenever you load that site. Open the
website and in the Safari menu, select Settings for This Website.

) = @ bdmpublications.com ¢, 27
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fdofocks |
ser Magazi

When visiting this website:

Use Reader when available

Enable content blockers
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Page Zoom and Auto-Play are set with pull-down menus that appear
when you hover over their current values. By default, the Auto-Play
function stops videos with sound automatically playing when you
open a site but you can override this using the Auto-Play menu.
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Safari’s Top Sites.

Top Sites gives you a window full of useful shortcuts to
your most frequently visited sites. Here’s how it works.

tory Bookmarks Develop Window Help $ 71O O™M 3 T
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Click on the URL field at the top of the browser to access a
window showing a grid view of website thumbnails you've marked
as favourites, along with those you've visited most recently.
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To add a site, click the URL field to open the Top Sites
window and then drag the URL into it. You can drag icons
around the Top Sites window to reorder them, or out of the
window to remove them.
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Pinned Sites

History Bookmarks Develop Window Help
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Close Tab
. Close Other Tabs
cate‘énryy Q Searchfo  Move Tab to New Window All Catel

Arrange Tabs By >

Elactronics Sports & Leisure Collectables

Wikipedia
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If you're not currently in Tab view, go to the View menu

and select the Show Tab Bar option near the top of the
menu. Now open the site you intend to pin and right or
CTRL-click on its tab. From the pop-up menu, select the Pin
Tab option.

@ Safari File Edit View History Bookmarks Develop Window Help

l ﬂ https://www.ebay.co.uk

Wikipedia

ece o @
BN o & 08B

Daily Deals

Hello lan. ~

Home & Garden Electronics Sports & Leisure Cdo

Apple
Obsession

The site gets a small tab in the left-hand side of the tabs

bar. This is always in place, ready for you to click on it
and open the site. You can pin multiple sites in this way. They
all appear as small tabs, showing a symbol or letter indicating
their content.

Unpin Tab

BDM Pul

Innovate, Edu

To the Top Sites window, macOS Catalina adds: Siri
suggestions, sites from your Reading List, bookmarks, tabs
that are open on other Apple devices signed into the same
Apple account as your Mac and more.

3 To remove a site’s pinned tab, right-click or CTRL-click
on it and from the pop-up menu, select Unpin Tab. The
previously pinned tab then becomes a regular tab. You can
reorder your pinned tabs by dragging them within the tabs bar.



The Safari Reading List
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The Tabs Audio Indicator
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To save a page for later, click the Share button and select

Add to Reading List. To view your Reading List, open the
sidebar and click the middle button (the spectacles). You see
the title, a thumbnail, and a brief summary of the page that
you saved. To revisit any of the pages in your list, click on the
list entry to go straight to it.

D oM § 2 0onlh ®m Tuzieem 2

e €
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Google

Websites that play audio as soon as you open the page

are really annoying. Thankfully, individual tabs can be
silenced using this simple Safari tip. In Safari you can tell which
one is making the sound. Just look for the tab with the speaker
icon, shown on its right.
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Facebook

You can search your reading list by typing in the search

par at the top of the list, and view only unread links by
clicking on the Unread button. To remove a site from your
reading list, right-click or CTRL-click on the site you want to
delete and from the contextual menu that appears, select
Remove ltem.

Stop Online Tracking.

Some Web advertisers track your online behaviour. To
protect your privacy, Safari can block this. In the Safari
menu, open System Preferences, click on the Privacy
tab and tick ‘Prevent cross-site tracking'.

( ] Privacy

General Tabs AutoFill Passwords Search Security Privacy Websites Extensions Advanced

Website tracking{ I Prevent cross-site tracking

Cookies and website data:  Block all cookies

Manage Website Data...

Apple Pay and Apple Card: [ Allow websites to check for Apple Pay and Apple Card
Safari allows you to make purchases on the web with Apple Pay
and Apple Card using your iPhone or Apple Watch to confirm you

payment.
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You can mute this sound by simply clicking on the

speaker icon. If more than one tab is producing audio,
right-click on it for more options. You can see which tabs are
making a sound, mute that particular tab or mute all the others.
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3 If the audio is coming from a video, you can enter picture-
in-picture mode from the Audio icon; right-click on it and
select the option. This puts the video in a floating window, which
you can watch while doing other things on your Mac.
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Using Bookmarks.

If you find a site that you like and would like to keep
coming back to it, you can add a Safari bookmark.
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Add a bookmark for a site by clicking on the Sharing icon and
selecting Add Bookmark. You can also use the Add
Bookmark option from the Bookmarks pull-down menu or
press CMD-D.
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You can access your bookmarks by using the Bookmarks
pull-down menu. Click on one of the listed sites to open it in
the current window. Bookmarks can be arranged into
folders, thus grouping similar sites.
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Click on Bookmarks and select Edit Bookmarks. From here,
you can edit the names of bookmarks by right-clicking, arrange
them into folders (see the New Folder button) and delete them
by dragging into Trash.

Getting More from Safari
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The Show All Tabs view, available via the View menu, lets you view
thumbnails of all the tabs you have open. Click one to open it, and
click '+ for a new one. At the foot of the window, you'll see tabs
open on other devices logged in with the same Apple ID.

New Tab & netflix.com
Open File...

Export Bookmarks...
Print...

+ MylList

@ More Infay
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Private Browsing

Private Browsing lets you browse the Internet without adding
tracking cookies or recording where you've been in your history.
Activate Privacy Mode by selecting New Private Window in the
File menu. In a private window, the URL field is darkened.

) © My 3

Develop Window Help

lew History Bookmarks

= ) 10

[in] & google.com

Google Wikipedia Black Dog

z Clearing history will remove related cookies
and other website data.
History will also be removed on other devices signed into
your iCloud account.

Clear all history E
? Cancel Clear History

4 vvslv**

Clear Browsing History

In the History menu, the bottom option clears your browsing
history and website data. Hold Alt while you select it to delete
your browsing history, but not website data. To clear more
selectively, select Clear History in the Safari menu and use the
pull-down menu.
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If you attempt to log on to a website using a password that's To change the search engine Safari uses by default, select
weak or easily guessed, Safari gives you a warning and Preferences from the Safari menu. Click on the Search tab and
suggests you change it. Click Change Password and Safari from the pull-down select the search engine you want to use.
suggests a stronger one, which is stored in your keychain. The sites on offer are Google, Yahoo, Bing and DuckDuckGo.
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Integrated Spotlight Search Safari Extensions

Spotlight search is a closely integrated feature of macQS, You can add extensions to Safari to expand its functionality.
including Safari. From the search bar you can find links to web Open Safari’s Preferences window (Safari > Preferences) and
pages, bookmarks, browsing history and documents on your select Extensions. Click on the Get Extensions button to

hard drive, simply by typing a search term. access a web page, from where they can be installed.

The Reader View.

Safari's Reader View cuts down on the distractions and lets you concentrate on what it is you're trying to read.
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"Apple (company)" redirects here. For other companies of similar name, see
Apple (disambiguation) § Brands and enterprises.
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The Reader View isn’t available on every web page. Look for The Reader View can be configured to your own requirements.
these lines that appear in the left-hand side of the URL field Right or Ctrl-click on the Reader View icon and you get a menu
when you hover the pointer over it. If they're there, you can as shown, from where you can opt to always use Reader View

click them to access the Reader View, for a simpler (and easily on the current site. You can also click the two As icon to change
printed) page. the font, size and more.




Your Mac’s Key Software Apps ’

Mail App
Send & Receive Emaill

Catalina has a great bundled email application, so sending and receiving
emails is as easy as typing a message and clicking a button. Here's how to
get the most from Mail.

2 3 4 5 6 i 18

This button downloads new emails.
You can set your Mail app to check
automatically but this button does so manually.

eloe
2 #

Inbgx — larl's emails (3f

98 9 [s®)r b

When you want to write a new email
from scratch, click on this button to

Open a blank one. 11 [ Mailboxes [Inbox (6) v VIPsv Sentwv Draftsv Flagged v ]‘m
3 ; il Sort by Unread v
This button archives the selected Nalises - 13 2 [ 1an ¢
. v &2 Inbox lan Osborne 02
message. Very useful if you want to Essential AppleUser Magazine Esser

make sure you don't delete it. 4 lan's emails [ 5] Have you seen this? It's the new issue of Essential

14 & TalkTalk address AppleUser Magazine! The Baron Lk
If you want to throw away the currently & icloud o ® Amazon Echo 10:34
selected email, click here to send it to et ‘S’hat to as';A'exa e Hav
v iscover what's new with Alexa this week. I've got
the Trash folder. ﬁ il football fever. Just say, “Alexa, sing me a football... The
. . 15 Yt Alison Drew The Spoon 09:42
This button moves the selected email to Y Claire Porter Cornered Cummings )
your junk mail folder. Use it to help the Plus: microplastics in your cuppa, Trump's ‘cover- |Ph0|“|
Mail app |dent|fy ‘spam' which is junk emails. * James Gale up', Saudi opens up to tourists, 'unacceptable’ to...
¢ Jon White Medium Daily Dige 08:50

These three buttons let you reply to the

selected email, reply to everyone who
received the selected email and forward the
selected email to a third party.

Y Karl Linstead
Y& Mark Ayshford
* Mark Kendrick

How to Use Writing ically Improve Your R...
Stories for lan Osborne Today's highlights How to
Use Writing to Radically Improve Your Relationshi...

trash nothing 08:29
Daily Digest - September 27, 2019

* Trisha Ball Daily Digest September 27, 2019 at 8AM All Posts
\ | Your Posts | New Post Offers 2 x single mattress...
7 This pull-down menu lets you mark the » [ Flagged &
o : : Elaine Wu via LinkedIn 08:08
Qurrent email with a flag,‘ yvhlch is » [ Drafts B WO OT R s ae
useful if you want to group mailings lan Osborne You have 1 new message Elaine Wu
according to criteria of your choice. » < Sent Marketing Manager View message View message...
» &7 Junk 215 GoGroopie 07:27
Use this button to silence notifications » ﬁ Bin FREE DELIVERY! £29.99 Rain & UV Resistant D...
th ds that di t See online version TODAY'S SPECIAL DEALS UV
O|n reaas that are sending you 100 > E Archive & Rain Protection Doorway Canopy in Black or W...
many alerts.
GAME 06:38
Smart Mailboxes FIFA 20 is here! Plus, NEW announcements...
This pull-down menu is another way of ¥ Today Did we mention they are GAME XCLUSIVE
moving an email into another mailbox ¢ P announcements? View online | Unsubscribe PLAY...

or folder.

To search for a specific subject,
person or word/phrase in your emails,
use the field here.

{} Essential iPhone & iPa...

20

Pinterest Yesterday
Pastel goth, Cybergoth and other topics for you...
Check out these 6 new topics picked just for you!




This icon opens and These are email The Sent folder. Click on Smart mailboxes let
closes the sidebar inboxes and as you it to see sent emails. you set up rules, so
shown here. can see, we have four email Open them and you can emails that meet the
accounts set up in Mail; forward or resend them. conditions applied appear in
These dropdown however, you can have more a smart folder as well as in
menus let you navigate  or less if you prefer. 17 Junk emails are sent the main inbox.
between mailboxes and can to this folder. You can
be used instead of clicking When you identify a move them there yourself. When Mail is
on the sidebar. sender as a VIP their downloading new
name appears in this section. Emails you've thrown emails, a message appears
13 Click this circular icon Click the triangle to open and away are sent to the at the foot of the sidebar,
to toggle between close it, and click on a name Bin. You can take them out showing how many there are.
showing all emails and only in the list to see emails from again, or empty the Bin, just
unread emails. that person. like the macOS Dock’s Bin. Your emails appear

here. Unread emails are
shown with a blue dot to the
left. Click on an email to open
it in the main window ('22').

This is the main

window, showing the
currently selected email.
Emails can contain text,
images, links and more.

S 70O P T« 00%EDd & S Fri11:04am

ils (36,584 messages, 5 unread)

B3 Move to... '—n Q m
This is the time the

lan Osborne ~ §4 B3 Inbox - lan's emails  11:02 23 . .
email was sent. If it

@
Essential AppleUser Magazine W — - today el i

To: lan Osborne
shown here too.

If the email’s sender is

in your Contacts and
has a picture, it appears
here. If not, it’s just a grey
circle with an initial in it.

Have you seen this? It's the new issue of Essential AppleUser Magazine!

The Baron m :
hone * MacBooks ¢ iPad * Mac * iPod touch » &« Watch » &« TV 3

100% INDEPENDENT

ESSENTIAL @eovs S Updated

Classic
AppleUser™ =
A\

M A G A Z I N E column-based layout, in the
View menu, select Use Column

X Layout. You can also check or

\_ uncheck Show Side Preview, to

set the email preview to the
side or below the list.
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Sending a New Email

View Mailbox Message Format Window Help
B W T €& < AR 2z
To. James Gale~
] Mailboxes \ Inbox v VIPsv Sentv Drafts v Flagged v Ce: | Mark Ayshford ~
Mailboxes Sort by Date v 2
% 2 = From: lan Osborne - Bt sum Signature:
v &3 Inbox Medium Daily Digest
An FBI Behaviour Expert Explaing|
A3 lan's el 5 for 1an A
£ TalkTalk 2
Eltima
Re: Thunderdrive
v * VIPs Hi lan, Thank you for reaching u
CloudMounter does not support
Y Alison Drew e
Here we show you how to open a new, blank email, write To send someone an email, type their email address into
a message and send it to a given email address using the box marked To:. To also send it to someone else,
the Mac’s Mail app. To send a new email, click on the button in add their email address in the Cc: box. Add multiple email
the top left corner of the screen, with a picture on it that looks addresses in either box, separated by commas, to send the
like a pen writing on paper. same message to a group of people.
t View Mailbox Message Format Window Help 1
080 < | =~ &

To:  James Gale~
Cc: Mark Ayshford~
Subject: Things to discuss

From: lan Osborne — st s Signaty

To: James Gale v Hifolks,

Here's a list of subjects for tomorrow's meeting. Let me know if you've anything to add, before | type it up as a formal agenda.

5 1: Schedules for the new titles.

Ce: Mark Ays hford v 2: The website; it's almost ready, but approval is needed on a few things.
3: Acquisitions. The new magazine we're publishing, details to be settled.

4: The new office building; is the move stil going ahead?

Subject: Things to discuss 5: Any ofher business.

Regards,
lan Osborne

From: lan Osborne - instss-maiseiss o

3 It's always a good idea to put something in the subject Once you've finished typing your letter, click the Send
line, even if it's just ‘Hello!". Type the body of your button in the top left corner of the email panel to send it
message in the large space below. An email can be as long as  on its way. Email is usually sent very quickly, and your
you like and you can use different fonts, colours and sizes if addressee should receive it within a couple of minutes, as long
you really feel the need. as there are no issue with their connection or provider.

Customising Mail.

&M 3 T ) 0ok L B Frifld0am )

® Fonts & Colours
General - - . o
- 4 > N A s e

= o0
A oo 5
i L AR General Accounts Junk Mall Fonts & Colours Viewing Composing Signatures Rules

Defouit omail reader: | %, Ml Message list font: System Font Regular 12 Select...

Gheck for new messages:  Automaticaly
Message font: Helvetica 12 Select...

MNew messages sound:  New Mes

Fixed-width font: Menlo Regutar 11 Select...
Cock 25med ourk Use fixed-width font for plain text messages
New message notifications:

& Colour quoted text
Downlosds foider: m Downiosds [ a S

Remove unedited downioads:  After Message is Deleted 2 [ Purple B Level One
Archive ox dalets muted mesmsges B Teal B [[|eee
Add invitations to Galendar automatically =
Automatically try sending ater # outgoing server is unavailsble [ Green

3 Protor

| Level Three

When searching all maiiboxes, include results from:
8in
Junk

You can customise your Mail app by opening it and, in the Mail ~ The Fonts & Colours tab lets you change the fonts and text
pull-down menu, selecting Preferences. Under the General tab,  size used with incoming emails and change the colours of
you can set an interval to check for new messages, decide quoted text. Explore the Mail preferences and set up how you
where downloaded attachments go and more. choose, but be careful with the server settings.




Receiving Email.

When you receive an email in your inbox, this is how
you open and read it using the macOS Mail app.

—— o7 g, ToTTeROy

(=R ] H @ B 6 ¢ = - B

B Move to. Q
[ Mailooxes  Inbox(10) v VIPsw  Sentw Drafisv Flagged v
Maitbozes
¥ £3 Inbox
S lan'semails €D
2 TalkTalk address

Agenda Community summary

[Agenda Community] Summary

To: Ian Osborne

Reply-To: Agend

® Netflix 03 i
Vie've just added a TV programme you might like

v ¥ ViPs
r Alison Drew
F Claire Porter
Y James Gale
& Jon White
# Karl Linstead
¢ Mark Ayshford
#r Mark Kendrick
4 Trisha Ball

Agenda Cor|

Eitima Yesterday
Eitima user activation

Once you've set up your email account, you can send
and receive email. As soon as you launch Mail, it
connects to your email service and collect any email that
is waiting for you. These messages are shown as a list in
your Inbox. Click on one and it’s displayed on the right.

W T @ « <

L] Mailboxes e { v Drafts v Flaggq

Mailboxes jate v

v 3 Inbox
~2nda Community] Summar

£ lan's emails A brief summary since your laj

While Mail is running, it periodically checks the server for
new messages. You can also prompt Mail to look at the
server immediately by clicking the button in the top left of
the screen that looks like an envelope.

Adding Attachments.

Inbox - iCloud (5,213 messages, 1 unread)
[% 8 W © N N > [l 2

B Mmoveto...

@s Inbox (10)v VIPsv Sentv Draftsv Flagged
Sort by Date ¥
MacFormat is out! Civil War Times Click

- . Now on Netflix
Medium Daily Digest

semails @ Permission to Be Weak | Jonas Ellison

KTalk address Stories for lan Osborne Today's h
- Netflix

w added a TV pr
son Drew i "
pire Porter Medium Daily Digest

You'll Need to Learn These Harsh
mes Gale Stor n me Todar

lan 0

In White

rl Linstead
Brk Ayshford
ark Kendrick

Replying to & Forwarding Email

If someone you know sends you an email, you'll probably want
to reply to them. Simply click on the email so you are viewing
the text of it, then at the top of the screen you'll find a row of
three buttons. The leftmost one has a single left-pointing arrow
on it. This is the Reply button.

If you click on this you'll see a window pop up that looks a lot
like the window for a new email, but it will have the responder’s
email address already in the To: box.

Next to the Reply button is a similar button with two left arrows
on it. This is the Reply All button; use this with extreme care. If
you have been sent an email that has also been sent to a
number of other recipients, hitting Reply All will send your reply
to everyone who received the original mail. Obviously if your
reply was meant to be private this is a very bad idea, and has
got many people into trouble.

The rightmost button of these three is the Forward button,
which is used to send an email you've received to another
recipient. Forwarding emails is another thing that requires care;
make sure that you don't accidentally send private information
to someone who was not meant to receive it.

Almost any type of file can be attached and sent over the Internet along with your email.

& Al © @~
Signature: = None

To add an attachment, first start an email (or reply to one you
received), and then click on the button bearing the picture of a
paperclip, at the top right of the email panel. This will open a
Finder window, allowing you to navigate to the file or files that
you want to send. Select the ones you want, then click Choose
File to attach them.

Jim,

foars sent her new photograph for her by-ine. What do you think?

Quick Look Attachment

Save Attachment
Save to Downloads Folder
Share

View as Icon

Import from iPhone or iPad

Import Image

In Mail, pictures you've included as attachments are shown in
the body of the email for convenient viewing. This means you
can turn your email into a mini-illustrated article if you want; or,
if you don’t want to display it as an attachment, click on it and
from the contextual menu, choose Show as Icon. It can still be
opened by the recipient.
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The Mail Markup Feature

G View Walbox _Message Format _Window _Felp : =8 S RO &= W FEpm W

) - A | © B

Andrea Gale~

The kids

Hero they are, in all heir erm, o

The Markup feature lets you add notes and scribbles to

pictures that are attached to an email before you send it. To
begin using the Mail app’s Markup feature, start writing an email
and attach a photo to it in the usual way.

Andrea Gale -

The kids
lan Osborne - s i e None ™
| A y Medium o

Here the il the i e
ere they are, in all their, erm, glory! ~
al
<
<
& |
i
=

# Repair Tool
More...  4new

Click on the attached image, and then click on the small

arrow that appears in the upper right corner of the
photograph. Select the Markup option to open the Mail app’s
Markup feature. You can also use certain third-party apps to
edit photos this way.

[ ——
P4 B2 S | = B

o- 3

Cancel Done

You can now use the interface that appears to add text,

drawings, or a range of shapes and symbols directly
onto the photo, in the email environment. When you're
finished, click the Done button and either mark up more
pictures or send your email as normal.

Move to...

Highlight or open an email and you see a new pull-down
menu marked ‘Move to...” in the toolbar. This lets you move
it to one of your folders including Trash, Junk, and folders
you've set up yourself. Mail also offers suggestions for
where it thinks you might want to move a mail.

Inbox — lan's emails (36,598 messages, 9 unread)
@ - vl B B3 Moveto...
lagged v = Inbox
~ lan's emails
e ~ TalkTalk address
99 at Vue Torbay " iCloud
o) R NEXT Drafts
Sent
16:52 Bin
vhimsical world of phot... Yionk

es his top tips for

1 game creators Wendel... = Archive

5:2
LY £12.99 | Easy Store...
S SP L DEALS 4 x
th Sheet

Show Only Unread Messages.

You can hide emails you've already read by clicking this
icon. Now only unread messages are shown. Click it again
to show all your emails once more. It's great for finding
emails that you received a while ago but haven’t seen yet.

nooX — lan's emaiis

)v VIPsv Sentv Draftsv Flagged v

Sort by Unread v Filtered by: Unread @

® VUE 16f14
Films showing for just £4
Find out what's on at Vue
SCREEN E
® Affinity Team f
(1] Spotlight: Step into the whimsical
Plus, Christi Du

Inktober, NucleAnts

Toit shares his top 1

GoGroopie
4 Luxury Bath Sheets ONLY £12.99 | Easy Store...

See online version TODAY’S SPECIAL DEALS 4 x

Flagging an Email.

To mark an email with a flag, highlighting it for later reference,
click on the Flag pull-down and choose a colour. You can add
more than one flag to a single email. To remove them again,
choose Clear Flag. The ‘Flagged’ option in the side bar
shows emails you’ve marked.

€« @ » A &3 Move to...

Orange

M Red

M Purple
Blue
Yellow

™ Green

¥ Re. Novel

ts v  Flagged v

r just £4.99 at Vue Torbay
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1
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Clear Flag
Toggle Flag




Mail Drop.

If you need to send large attachments via email,
the Mail Drop feature is very useful. It's really easy
to use too.

L ]

o: ' Jon White ~

The books you wanted

1an Osborne ~ e v

= = = =
1-Market
Garden.pdf

2-Battle of the
Bulge.pdf

3-Monte  4-victory in the

desert.pdf

If an attachment you wish to email is too large for a regular
emall, it's stored on Apple’s server and offered as a
download instead. Depending on whether the recipient is
using Mail, the attachment could appear as a download link
or as thumbnails.

Here, we received huge photos, which are displayed as
thumbnails. You can download them all by hovering over the
email and clicking on the paperclip as shown. They're kept
on Apple’s server for a month from the date they were sent.

Mail in Full Screen Mode.

Mai

Searching Your Emails

— E
oxes (Found 3,059 matches for search)
Q_pictures )
ed v People
Dinas Powys Pictures — notification+00s0f_zc@fac

Subject contains: pictures
Pictures

Pictures again

Pictures for VAIO interview

Pictures from Mom.

Attachments
Attachment name contains: pictures

Type your search term into the search field in the top

right. Suggestions are offered for items such as people,
subjects and attachments; emails that meet your search
requirements are shown in the email list.

Friaaspm @ Q &

$ 7

SR F T wnED L =

tches for search)

Q B Pictures %]
v Subject
Entire Message

Save

After clicking on one of the suggested items, you can

adjust your search by clicking the first word in the field
and choosing a new option, as shown here, or even adding a
second search term for more advanced searches.

The Mail app’s full-screen mode works in a different way to other apps. Here's a guide on how to use this useful feature.

» P Flagged
» [ onns

@ FANATICAL

AKRACNG ™

FNATIC

£ Unvesa
£ EssentialPhone & 7

Aye

£ competitons

= WIN

GAMING PRIZE BUNDLE
WORTH OVER $1,100

PLUS 3 x $50 SPENDING SPREES
FOR RUNNERS-UP

Writing or replying to an email when the Mail app is in full
screen mode involves working in a split screen view. Click on
the green gumdrop in the top left corner of the Mail app
window to take the app into full screen mode.

o
Hello from Salisbury, MARK—’S

1t can sometimes be hard 1o strike a balance

between authenticily and drama when it comes fo

Our guest this week, Jerri Willi has been Hotlo Soms Sslstiry:

heiping writers get FBI cha

1t can sometimes be hard 1o stk a balance between authenticty and drama wi
procedures cortectever since she ef the omes to wrkting abotlaw enforcemant. When do you stck [0 realty, and whe

okay 1o take a littie creative license?

Qur guest this week, Jerri Williams, has been helping writers ge!
procedures cormect ey u, having worket

Hollywood - from the myth that local police and
the FBI never get along, 10 the idea that the FBI
sends an agent 10 every bombing or murder.

We aiso talk to Jerr a

books.

We also tak to Jerri her own crime-fiction bocks, and how she initialy hoy

Start a new email or reply to one. The screen is split, with your
outgoing email shown on the right. Drag the dividing line to
make more room for the email app. The email’'s gumdrops are
shown by dragging your pointer to the top of the screen.
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Using Mail Signatures.

You can add a signature to your emails, that is, a short
piece of text that's at the foot of every email you send.

S W = 9 s X = raaen

Show All

(oW lan Osborne
QUEM 570 sqnataes Group Edilor, Apple Bookazines
Papercut Linited / Black Dog
Media

Ttak aoress Tot 01626 362264
Email
e lan@bompuntcatons.com
@ v bmp.plcations com

Bdmpublications
Taiktalk
[ e

TQ12 1AH

Abways match my defautt message font

A signature is a piece of text that you can add to the foot of
your email automatically. To set one or more up, open Mail
Preferences (from the Mail menu), click on Signatures in the
top bar and then on the account to which you wish to add a
signature in the accounts on the left. Click on the '+’ button
under the middle column to add a signature.

M: 1an OSbOrne — i sl sesfibsisd wigums s, Signature v None ]

Name & address
Work sig
Name & email

Edit Signatures

You can click on the name of it in the middle column and
change it to anything you like, and write your chosen
signature in the right-hand column. It can be anything you
want. Now, when writing, forwarding, or replying to an
email, you can add or remove your signature using the
pull-down menu to the right of the From field.

Accessing Emojis.

008 < | = é A

1an O500rNe - s masfirar e
g Jim, o Book's cone at st

Pany tme toight! Iy =

The Mail app has an emoiji picker to use when writing an
email. Click on the smiley face in the toolbar and you get a
choice of emaji to add to your email. To add it, just click on the
one you want. Scroll up and down, or click the icons at the
bottom for more choices.

New for Catalina

Inbox (42,178 messages)
2 & H @ W & &> *o
[ ... . ] Semv Onfisv Fagged~

® This message is from a blocked sender.

 Enable blocked mail fitering

When email from blocked address arrives:
= Mark a5 blocked mail, but leave it in my Inbox
Move it to the Bin

e iy Digast
“The Spoctocuiar Fasure of.

Entar omail addresses to biock i the list below:
144207046 1837
+44 800 092 0762
+44 1844 398600
444 1285 864670
+44 113322 6370
+44 207946 2090

Medium Daily Digest
“The ldea That Changed tha.

fam Osborne
Surte

444207048 2228
+44 1603 564962
144151028 2615
+44 800 156 7738

Medium Daily Digest
“Wiy s 8 Myth That Fascis.

Block Sender

To block a sender who sends you emails you don’t wish to
receive, click on that person’s name in the incoming email and
select Block Sender. To stop blocked emails reaching your
inbox, in Mail Preferences, go to Junk Mail and click the Blocked
tab. Select ‘Move it to the Bin' to send emails from blocked
senders straight to the bin.

~ >
B Inbox (42,178 messages)
2% Bl @ Tl & & > .3 H Move to.
D maiores EITTED vos < Semtv Dty Flagged v Unmate selected conversations
Maltboxes Sort by Date v

Found in Sent - iCioud Mailbox

lan Osborne
Re: Today's Evening Standard
To

Yaan, s geting prety bad. But at loast Donalg Trump Jr's omalls are provicing a e

ght relel. )

Rogards,

lan

o0 M o Gl Coah

* Claire Connelly o
Re: Today's Evening Standard

oi lan Osbore

wesk

Gosh
pows. @
Claire

yourbill@talktalk.co.uk

Mute Thread

If an email exchange is throwing up too many notifications, you
can mute it by clicking on the crossed-out bell in the toolbar. The
emails still arrive as usual, but, until you unmute it again, you
won't get notifications on delivery.

Tnbox =iCloud (5,213t

= @ =-» v A B3 Move to... Q

s v Flagged v
Netflix v
We've just added a TV programme you might like “

To: lan Osborne

B This message is from a mailing list.

lv Digest 08:5¢( For You
r Expert Explains How

Etivation

he, Thank you for contacting
e Support! A new Eltima Hel

Unsubscribe

If an incoming email is from a mailing list, the Unsubscribe link
now appears right at the top of the email. Click the Unsubscribe
link to stop this mailing list from sending you emails in the future.
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=mn FaceTime App
= Video & Audio Calls

With FaceTime, you can video chat between devices, including iPhones, iPads
and your Mac. You must have a video camera, whether it's a built-in FaceTime
one or an external USB model. Then you can use your Mac as a video phone
to chat face to face with anyone who has an Apple device, wherever they are.

fleo Window Help % & 1 S B 3 2 %) 0xEs 2 = Mon/0im @ Q

Facelime

.+ | cancel

Click on the FaceTime app to launch the program. It

should start straight away, and you'll see your own face
on the screen, as well as a panel inviting you to log in with your
Apple ID. Type in your Apple ID password and click OK.

fleo  Window Help S B 2 F % kB 2 = Mn70ipm © Q

. Alison Willis

Next you'll need to type in your email address. This is the

address that people can use through the FaceTime app
to contact you. There will be a brief pause while FaceTime
verifies your email address.

Edit_Video Window _Help. 3

) OB 3 % %) 00%E8 L B3 Mon70ipm O

Before you make a video call, it's a good idea to make

sure they can see you properly. Using the camera view
shown here, make sure there are no distracting bright lights
behind you and your face is well lit. You don't need to light up
like a movie studio, but turning on a desk light could help.

Edt_Video Window _Help % 3 7

To start, look up the person you want to call in your

Contacts list, scroll down and you find the FaceTime call
button. If the person in question isn't in your Contacts app, you
can call them by typing their name, email address or phone
number in the field provided and pressing Return.
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ime  Edit Video Window Help e M 3 2 0 00%E 2 B Mo

Alyssa Falcon Accept -

FaceTime
Decline | ~
Reply with Message...

Remind Me in 5 Minutes
Remind Me in 15 Minutes
Remind Me in 1 Hour

Accepting a call in FaceTime is also extremely simple.

When you receive a call, the app automatically opens
and you're given several options. These are Accept or Decline
the call, and under the chevron, Remind me in five minutes, 15
minutes or an hour, or Reply with Message. You also see your
camera view in a small inset window.

Hover over the FaceTime window and click the icon

showing two arrows pointing away from each other to go
full-screen with your video chat. If the other person’s chat is
shown in portrait mode, it's because they're holding an iOS
device in that orientation.

FaceTime Audio Calls.

It's also possible to make audio only FaceTime calls. From
the Contacts app, find the person you want to call and
right-click on the telephone receiver icon at the top. Choose
the option for a FaceTime Audio call. Alternatively, in the
FaceTime app, right-click on a previous video conversation
found in the left-hand sidebar, and select FaceTime Audio. If
the entry shows a telephone receiver icon, it was already an
audio conversation, so you can just click it to repeat the call.
Naturally, you can enter an email or phone number in the top
field and as long as the other person has registered that
email or number with their FaceTime account, you can make
the FaceTime call. Because they’'re made over the Internet,
FaceTime calls, audio and video, are free.

Whilst you're in the call you can mute the microphone by

hovering your pointer over the picture and clicking the
icon that appears at the bottom. Hover over the inset video
feed of yourself and you can toggle between landscape and
portrait modes. Take a Live Photo with the button at the bottom
left. To end the call click on the red button.

You can change the orientation of your own video by

hovering over the window showing your own video feed
and click the curly arrow to change it from portrait to
landscape and back again. Match the orientation used by the
other party for bigger on-screen video chat.

® o
iCloud

7 Aldridge Sch
+ Allson's Phone
« Family
+ For Freelance
tan's Phone
- MacFormat
- Odds & Ends
- Online Chums
+ Professional Contacts
+Rolle College
+ Work & Ex

Powderham Vets - Newto
simon darcy abbott
James Abeler

Jenniter Adams.

Adobe (Red Consultancy)
Nadia Aharchi

Howard Altchison

Selene Alford

Hamzah Ali

Christopher Allen
Amelia Alvares

Sroart Orovps Amanda

LatpCt Amazon

Woody Anderson
Stuart Anderton
Andrew Price & Co
Mac Repair Angeles Mac...
Bandar Antabi
Aoc

Apple Computer Inc.



Group FaceTime Calls

System Preferences Edt View Window Help TED: " VoM 3 o @ sy Thug20pm @

Edt_Vides Window Help. 7 T W F = W) WoREw I @ Won/0Tm O Q)

Software Updste (aF |

Your Mac is up to date — macOS Catalina 10.16
Last checked: Today a1 20:20

Automatically keep my Mac up 1o date Advanced.

To make Group FaceTime calls, you must be running at Establish a FaceTime call with someone then drag the
least macOS 10.14.1 (Mojave), iOS 12.1 or an iPad pointer onto the FaceTime window to reveal the control
running the new iPadOS. Update your device if necessary. icons at the bottom. Tap the icon on the left to reveal the side bar.

EIt_Vides  Window _Felp oo B &

Edt_Video Window _Felp W ¥ T S W =9

W Won70ipn @

Add person

alyssa
AlyssaFalcon  alyssa faleon@icloud.com
AlyssaFalcon 020 7930 8181

Cancel

To add another person to your FaceTime chat, click Add Up to 32 people can join a Group FaceTime chat. To
Person and then enter their details. Tap their name as soon leave, click on the red button in the series of icons
as it appears, then click on the green Add button that appears. shown in the bottom left. The rest of the group is unaffected.

Providing you've updated to the operating systems You can even Group FaceTime from an Apple Watch or
covered in Step 1, you can mix Macs, iPhones, iPads a HomePod speaker, though as these devices don't have
and iPod touches in Group FaceTime chats. They all work fine. built-in cameras, you are limited to audio chat only.
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L1 Your Mac’s Key Software Apps ’ New for Catalina

The Music App
Adios, ITunes

With the introduction of macOS 10.15: Catalina, Apple abandons that

old workhorse iTunes and replaces it with Music, an app that will already
be familiar to iPad and iPhone owners. It's another step towards greater
integration between the Mac and its smartphone and tablet stable mates.

Catalina’s new Music app is ® Music File Edit Song View Controls Account Window Help & &

very similar to the one found
on the iPhone or the iPad, but
e e @

if you’re familiar with iTunes,
you shouldn’t have too many

problems getting started. Q_ Search
When you're using the Music Apple Music Fo r You
app, the top bar gives you u For You o B
pull-down menus offering controls and Browse
options. It's worthwhile familiarising ™ Radi
) adio
yourself with them. music
The Search field: Completion Lt New Music
suggestions are offered as you () Recently Added Mix
type, and results can be limited to Artists
Apple Music, or your on-Mac library, as P Albums m
you wish. Results include artists, songs,
albums and more. Songs
y ; ; Q Music Videos SHADOW
When you're playing music, this B et
icon is replaced by the album art. Playlists 4 SEIVA &
Click on it to switch to the mini player, £ 90s Music -
which shows the album art and controls @ Music Videos
only, and takes up much less room on Updated Yesterday
the screen. Close the mini player to & My Top Rated m
return to the full Music window. = Alison's music
The controls: These are, in = Apple Watch Recently Played

turn, Previous track, Play/Pause,
Next track. The line underneath lets you
scrub through the track. As we're not
playing anything, the controls are
currently greyed.

=l Classical and Jazz
=/ Extreme Metal
=/ Female vocal

=l From iPad

=l lan's Music

=/ Untitled Playlist

The volume slider: Click and
drag the dot, and move it left and
right to change the volume.

The left icon opens a sidebar

showing the lyrics to the current
track. The right icon shows you what’s
next. Drag the pointer over the list and you
can remove tracks you'd rather not play.




home till I finish the
mission

Now that | know
(Now )

Nhat | know
(Whatl)

Thare's nothing
& (Motheng)

{Dale Play!

Music by Mood
= -
-]

Sat7Sep7é7.pm 2 Q 9

Top Songs

= Apple Music controls: If you
have an Apple Music account, For
You is the main page, offering suggestions
of music you might like and showing what
you played recently. Browse is great for
finding new music, and Radio gives
access to streaming stations.

This is the For You page, your
gateway to the Apple Music
streaming service.

®MuUSIC

This is the gateway to your Music

social network. Click on it and you
can find out what sounds your friends
are listening to, and discover and enjoy
new music together.

Favourites

These are the options for your
Library, that is, music you've
installed on your Mac. It can be arranged
into Artists, Albums, or Songs, and there
are sections for music you've recently

added and music videos.

Updated Tuesday
At the top of the For You page is New
Music, a playlist made up of tracks

chosen for you based on previous plays,

and a mix of your Favourites, tunes you play

a lot. Click the chevrons for other mixes.

These are your playlists. The top

ones are Smart Playlists, which
add songs automatically according to
rules, and the lower ones are playlists you
build yourself.

This is a round-up of music you've

recently streamed. Scroll this page
up for more suggestions, again based
on previous listens.

Click this link to see a wider range
of music you've recently played.




ﬂ Your Mac’s Key Software Apps ’

Signing Up for Apple Music

Let us find your next
favourite

Discover handpicked playlists & albums
based on the music you love. Download
and play millions of songs, even offline.

Try tNow

With an Apple Music account, you can stream from 50

million songs for a set monthly fee. To sign up for an
account, click on For You in the left-hand sidebar. You can then
click Learn More to read about Apple Music, or Try It Now.

Your first 3 months free — @ =

Individual

£9,99/month after trial ends

{Familyu 0 6 peop

University Student
4:99/month atter trial en

O HEl
L i

VAERS RE.0A8 @

Not Now

Click Start Trial and you're asked what sort of an
account you want. The first three months are free, but

after that it’s £9.99/$9.99/9.99 € for an individual. Choose an
account, and click Start Trial to begin.

Your first 3 months free o— @ =

Sign n to the iTunes Store
1 you v s Apcle 1D s s, ke tho hre H youvoused
= ; o

PR e —)
PP e
Remember password for free downloads

Create New Apple ID Cancel

Not Now
i Eﬂ .=m .! |
G £
o= |7 ARaEs O.=@™

3 You must then sign in to your Apple ID, or if you don't
have one, create a new one with the button at the foot of

File Edi Song View Controls Account Window Help  © @ ) O Bf B8 U 3 = ) &8 foonEm Sat7Sep B3pm 2 Q

Choose genres you love.

Your selections will inspire recommendations we make in For You.

There then follows a series of screens inviting you to
indicate what genres of music you like and then what

the pop-up window. Enter your Apple ID email address, then
your password, and then proceed to the next step.

bands. Follow the on-screen instructions and click the bubbles.
When you're done, you're ready to enjoy Apple Music.

Changing or Cancelling Your Subscription

e e @ - o=

e : asaach ¢
Aop M Aopie Music
3 For You L ForYou & 5
Brovso Account Access Browse Edit Subscription @ Secure Connec
(2 radio @ rato
m g o n Apple Music Membership
10 Abums. O Avums
S Settings A
Wi rere?
W mou : @ 905 Music dnicust 1 Naxt biing date: 01 Oct 2010
@ Music Videos. ) @ wusic Videos
on
bt 2 i) A 4y B P
2 lon's Music: A lan's Music: Options.

Flesat il warmings for buying and downloading.

‘Cancel Subserption you cancel now, You can stll acess your
‘subscription unti 1 Oct 2018,

ey Copyign © 2019 Aspl Citbctin Famsionst AL Ris Russrudad Prvasy Doy | Tomms ol Sanics

pee—

If you want to cancel your Apple Music subscription, first

of all, click Account in the top bar and select View My
Account. You're taken to your account page. Scroll down to
Subscriptions (under Settings) and click the Manage link

On the next page, you're shown your active

subscriptions. Click on Apple Music's Edit link, and on
the next page, you can change your subscription to a different
one (individual, family or yearly) or cancel it altogether.




Using Apple Music

TR vour Livary

Lust for Life
Lana Del Rey

Lustfor Life feat. The Weeknd)
13 Beaches
Chomry

White Mustang

Browse or search for the artist, album, or track to which you

want to listen. Here we're looking at an album. Click Play to
play it in its entirety;, or Shuffle to play the tracks in a random order.
Tracks marked with an ‘E’ in a box have explicit lyrics.

x e P o

m P Rocky & Playbol Cart) Summer O

EETEE vour Livary

Love

Lust for Life (foat. The Wesknd)

Groupie Love fleat. ASAP Rocky)
In My Feslings
Gaachela - Woodstock In My Mind

God Bloss America - And Al the Beautiful Women in It

Music controls such as Play and Pause are found at the top

of the window. To identify tracks on an album you
especially like, hover the pointer over them, and click the star to
their left; it becomes a heart. To change your mind, click the heart.

ﬂ The greatest

Apple Music [REATTNY

Lust for Life

Lana Del Rey
Now Payist
8 e : -
s Music | Play Next
Play Later
Creata Station
feos Love
= Disike.
e

Share Album »

Lust for Life (feat. The Weeknd)
! 13Beaches

Cherry a

Whits Mustang

Click the three-dots icon on the right above the tracks for

a menu. Here you can add the album to a playlist or
create a new one, share it with your friends, like or dislike the
album as a whole, or create a station based on its artist.

DT Your bvary

See Friends Who Have Listened to This

More by Lana Del Rey

m' OO |

BomtoDe

Apple Music is all about helping you to find music you

enjoy listening to. When viewing an album, you can scroll
up and other titles by the artist in question are shown. Click on
one to open it in the main window, click the chevron to see more.

Edi_ Song View Controls Account Window Help  © & © © 4 B

D F % 4) 8 100%8F Sat7Sep 603pm L QO =

Forvou Chonie wusic RTEN

[ r— -

Coachelia - Woodstock In My Mind

God Bless America - And Al the Beautiful Wormen In It

When the Werid Was at War We Kept Daneing o

Beautiful People Beautiful Probloms (feat, Stevie Nicks)

Tomonrow Never Game (feat. Sean Ono Leanon)

Play Next
P Change Play Later
Creste Station

Getinfo

Hover the pointer over a track to reveal a three-dots icon,

offering a similar menu that applies to that track alone.
You can also play the track by clicking the Play icon that
appears when you hover the mouse/trackpad pointer over it.

Browse

TRACK BY TRACK

NEWEP -
AltcH20

Weekend Vibes

The Browse section offers tracks, artists, albums, and

playlists based on Apple Music editors’ choices and new
releases. It also offers current charts for various countries. The
Radio section lets you listen by station or genre, and more.
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Importing CDs

Would you like to import the CD “Hits* into your music library?
J1 Do not ask me again

 Everybody Gets A Second Chanco
“ ABeggar On A Beach Of Gald

You can import your CD collection to your Mac, where it You see the track listing of the album appear. The progress
appears in the Library section of the Music app. If you bar at the top shows you each track being copied, while a
don't have a built-in CD drive, connect an external drive. Slot in green tick next to each track tells you which songs have already
a CD, and you're asked whether you want to import it. finished. It takes a few minutes to rip an entire CD to iTunes.
L] L ] 3 @ =
Q Search <
e ' |
g::- Hits oo imponco & e 9?18 Sln?Ies
US.:\'EMMM A v Name Time Artist Album Gerre
13 Artists. 1@ @ All Need Is A Miracle 96 5:43 Mike + The Mechanies. b dind, 20 Rock
0 stume 10 ET s e e
B o e et # e f v veseges o
e x o ——— o
.
5 o e vwo e vacrks e
@ 90s Music (1= 423 Mike + The Mechanics U218 Singles Rock
@ Music Videos LX) 4:24 Mike + The Mechanics. U218 Singles Rock
@ My Top Rated 00 452 Mike » Y218 Singles Rock
i e 20 tmasmha i e
N — 240 imas T
120 # AbooteOv A Baonct 00 £33 4. he achmic e
S e
o
e
3 Once you've successfully imported your album, don't You can play a CD on your Mac without ripping and
forget to click on the Eject button on the left side-bar. importing it. Just slot it into your internal or external CD
Your CD pops back out so you can store it safely away. The drive, and it appears in the Music app’s left-hand sidebar. Click
process of ripping a CD to iTunes doesn't harm the disc. on it and the tracks appear in the main Music window.

Other Music Features

Alanis Morissette (I:a‘ck @‘hlack
Amy Winehouse
Rehab 334
Black Sabinth You Know I'm No Good a1
Bob Dylen 11 SONGS, 36 MINUTES & yo Equaliser
) on Ra8 ]
Cherie Currie v I
ERRRRRES
||| T
Dumoys Rissty Nuts Pl-n\u 32 64 126 250 500 K 2K 4K Al
&  Wake Up Alone a2
Mini Player The Equaliser
When playing a song, click the album cover at the top of the On the keyboard, press ALT-CMD-E or go to the Window
Music window to minimise the app into the Mini Player. Hover top-bar menu to select the equaliser. This lets you adjust the
over the Mini Player window to see the controls. Click the X in sound. You can either move the sliders yourself, or choose a

the top-left corner to switch back to the full Music window. preset from the pull-down at the top of the equaliser window.




Shuffle & Repeat.

N SOE=E-N IR0

0!

x| <4 >
%02 ’ -3:32

When listening to an album, playlist or mix in Music, next
to the controls are the Shuffle and Repeat icons. Shuffle
(left) plays the tracks in a random order, while Repeat
(right) causes your list to start again from the beginning
when finished.

Music + Friends.

If you click the Repeat icon twice, it displays a small
number ‘1’ to the right and above it, as you can see here.
With this in place, it's only the individual track you’re
currently listening to that repeats, when it has finished, not
the entire album.

For You

&

fien

Music + Friends

‘See what your friends are listening to and find the best new
music together

Click For You, in the left sidebar, then click the icon or
picture in the top-right. A pop-up window for Music +
Friends appears. You can take a quick tour to see what it
does if you wish, or click Get Started to begin.

The Visualiser

The Visualiser is found under the Window menu, or by pressing
CMD-T. It gives you a visual show which ebbs and flows in time
with the music. Press ESC to quit it. Switch between a regular
and classic Visualiser in Window > Visualiser Settings.

For You
Find & follow

friends

Add a name and username, and an optional photo. You're
then invited to follow friends who also have Apple Music.
On the next screen, you can choose whether anyone can
follow you or only those you approve.

A Cheaper Subscription.

Edit Subscription 8

ﬂ Apple Music Membership

Your Subscription  Indwicual 1 Month - £9.99/month Next biing date; 01 Oct 2019

Options.

If you pay annually for your Apple Music subscription, you
get 12 months for the price of ten. In the top bar, select
View My Account from the Account menu, and next to
Subscriptions click Manage. Choose to edit your Apple
Music subscription, then select the one-year option.
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Ry
For Movies and Shows

The TV app has long been a popular means of buying and watching
television shows and movies on iOS, and now it's come to the Mac. If you've
already bought video media on the iTunes Store, in macOS Catalina, you'll
find it in the TV app. How does it work? Let’s find out.

File Edit Video View Controls Account Window Help © © @& © O S B O 3 5 ) 8 100%E# Sun8Sep 2:23

AMAZING o
GRACE ~ ¢

What to Watch

(g
FOR ALLLS (6

- Apple TV+ First Looks

Open the TV app, and click on the Account menu in the Look at the tabs at the top of the window. Watch Now is

top bar. If you're not signed into your Apple account, the TV app’s front page, showing movies and TV shows
select Sign In and enter your Apple ID and Password in the you've previously bought alongside those available to buy or
fields provided, then click the Sign In button below them. rent from the app. Scroll up for more suggestions.

fle_Edit_Video View Controls _Account Window Hep @ © & © O Pk B O e D 100% B8 Sun 8Sep 237pm &

§ = @) B8 100%F@ SunBSep 234pm 2

Season5 -
Season 6
Season?

Legend of the Big Red Chicken

Related

Buy £2.49

Cast & Crew

h

3 The Films and TV Programmes tabs take you to The Kids tab is, unsurprisingly, for children’s
movies, and TV shows respectively, available to buy programmes. Again, click a show, and scroll up to see
and/or rent. TV shows can be bought individually or on a which episodes are available. Click the triangle next to the

per-series basis; scroll up for available episodes. Season number and you can switch to a different season.




D) Recently Added
Qfm
(0 TV Programmes
anres
‘Action & Adventure
‘Comedy
orama
Horror.
Sci-Fi & Fantasy
‘Short Films

FENCES

Assassin's Cread

........
1 Apple Woteh 3

# Classieal and Jazz

U Extreme Matal

18 Female vocal

W From iPad

J Untitisd Playlist

VIE EN ROSE

Mission: Impossible - Ghost Protocol

34 fims, § day, 33.83 6B

The Library tab takes you to your collection of movies

and shows, those you've purchased previously. In the left
hand sidebar, you can view according to when you added
them, films only, TV only, or according to genre.

Lbrary <
10 Racantly Addad
O Fims
10 TV Programmes

[oenves
Action & Adventure
Comedy
orama
Harror
Sci-Fl & Fantasy
‘Short Films THE

OITHERS
8 Aison's music

1 Aspte Wateh

M Ciassical and Jazz
M Extreme Motal

§ii Female vocal

T From iPad

18 Untited Playiist

Delete from Library

4 fim, 1 day, 3383 6B

7 Click on the Three-dots icon, found by hovering over a
show, and you get a pop-up menu. This lets you
download the show, mark it as watched or unwatched, add it
to a playlist, get an interesting information window and more.

Mission: Impossible - Ghost Protocol

P S R
T RROMETHEUS
>

Prometheus Toy Story

Hover the mouse pointer over a movie or TV show in your

library and you get these icons. Click on the Play icon to
play it. The cloud with the arrow on it lets you download it for
later viewing. This is essential if you watch offline.

Buy £13.09
Rent £5.49

£ Add to Up Next

Trailers

When looking at a movie to buy or rent, scroll up and you

might find a trailer. These, of course, can be viewed for
free. The Add To Up Next button adds them to your Up Next
list, which is found at the top of the Watch Now screen.

Are you sure you want to rent Scooby-Dool Return to
Zombie Island?

Your payment method will be charged immediataly.

Don't ask me about rentals again.

cancol (D

Buy £0.99

If you choose to buy or rent a show, or film, you need to

sign into your Apple 1D account. You're then asked if
you're sure. Rented media is removed 30 days after renting it,
or 48 hours after you start watching it, whichever is sooner.

When watching a show, move the mouse pointer for
controls. These include pause/play, skip forward or
backward, close the viewing window, add subtitles, and watch

the show in a small window that floats on top of the desktop.
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New for Catalina

j;l Your Mac’s Key Software Apps ’

Podcasts App

Listen and Subscribe

With macOS Catalina, the iTunes application has been abandoned and
replaced by three new apps; TV, Music and Podcasts. The Podcasts app
lets you find audio programmes that interest you and download, listen to
and subscribe to them. Most podcasts are free too.

Q Search

Apple Podcasts
) Listen Now

& Top Charts

Library

Recently Updated
Shows

E Episodes

n Downloaded

These are your basic

playing controls. The
icon in the centre plays and
pauses the podcast, and
those either side of it skips
back 15 seconds or forwards
30 seconds respectively.

The currently playing

podcast. Hover over it
for a scrub line showing
details such as how long it is
and how much has played,
and a three-dots icon giving
access to a menu offering
various options such as Add
To Library or Mark as Played.

The Tim Vine Chat Show

sek — 2 September 2019 Comed

True Crime

TRUE CRIME - 2017-2019

sinister to the surreal.

The volume slider. The

volume for the
Podcasts app can be set
independently of the system
volume, which is found in the
menu bar atop the desktop.

The information icon.

Click it to show and
hide a sidebar containing
programme notes about the
currently open Podcast.

This icon reveals and

conceals another
sidebar, this time showing a
list of what's coming up next.

Trailer

SATURDAY

They Walk Among Us - UK

They Walk Among Us

% % % & ¥ 4.5, 2.2K RATINGS

v SUBSCRIBED  eoe

They Walk Among Us is an award-winning weekly UK true
crime podcast covering a broad range of cases from the

more

Season 1 - Exclusive to Patreon @

From Monday, September 16, 2019, Season 1 of

+ 5MIN

'They Walk Among Us’ will be exclusively
available on Patreon. The podcast has come a lo...

Episodes

The search field. You

can search podcasts
stored in your library or all
podcasts available through the
app. You can search for titles,
names, content and more.

7 In the left-hand sidebar,
click Listen Now for a

list of the latest podcasts
released in shows to which
you subscribe. Click on
individual podcasts to go to
that show’s page. You can
browse for new podcasts or
scan the latest charts for most
popular podcasts.

The back button. We're

currently looking at a
specific podcast. Clicking this
icon would take us back to the
page that brought us here.

The Library section of

the sidebar shows you
the podcast content saved on
your mac divided into Shows
and Episodes, along with
podcasts you have downloaded
for offline listening.

The main window with
all the information of
the Podcast you're browsing.




Using the Podcasts App

tMurders 0

Kent: The Tunbridg

Friday Night Comedy from BBC Appie Pogcasts Friday Night Comedy from BBC
Radio 4 Dt : Radio 4
9 crows i e BBC Radio 4

BBC Radio 4

019 kA A 45, 85K RATING:

Top Charts.

Ubrary p— Ubeary > Play Episode v suBSCRIBED  +e
D) Recentty Updated s () Recently Upcated ?
O shows.
e i 1 An cwell
3 Evuses Downioad the best satirical comedy from Radio 4, aver ReportaC e o T et .
Friday. Features The Nows Quiz, The Now Show, Dead ¢ ey
I Downloaded Ringers and Lobby Land. [

Share Programme >
Episodes My Episodes
News Quiz 20th September 2019 News Quiz 20th September 2019

stPTEMDER
The News Quiz Fri 13th September 2019

See All Episodes

To subscribe to a podcast, and have new episodes To play an episode of a show to which you've
automatically downloaded to your Mac to enjoy later, subscribed, click on Shows in the left-hand sidebar, click
browse or search for a show might like and then click the the podcast you want to hear and click the Play Episode button
+Subscribe button, or use the three-dots icon to its right. You for the latest show. Click See All Episodes at the foot of the
can use this three-dots icon to unsubscribe too. page for a list of other available episodes.
e g —_— Qe
::::W 2019 .:mcw
(B Top Charts. - UWW History True Crime Society & Culture
' et i Ao Cuke 235 s 2 el 2
o s G boreroatad Curated Collections
B pownioaded

Add To Library
Save Episode
Mark as Played
Report a Concern

FOR KIDS

g5 (row Play Next
from Fiety he s Produce * Play Later
Copy Link

. 4 z ShaeEpsade b

The News Quiz 30th August 2018
; ot 4

Goto Show

Lt B e S A it

When looking at a list of episodes in a specific podcast, Don't miss the Browse options. Click the Browse option

hover your pointer over one for a Play button, which lets in the left sidebar and scroll up to see Categories, which
you play it without downloading. Click the title for more groups podcasts according to genre. Click See Al for the full
information, the Plus icon to download whether you're range. Keep scrolling for curated collections, editors’ picks,
subscribed or not and the three dots for options. new seasons and lots more besides.

[T Fie Edit View Controls Account Window Help $ 4O O DO 2 T <) 00%HF 8 Mon12:20

e e Playback

[ O K-
i R

e e Advanced
>

General Playback Advanced
Continuous Pley: © Play the next episode when an episode ends

Stop when an episode ends . o )
Library: Sync subscriptions across devices

Automatically delete played episodes
Show Siri Suggestions in App

Siip Buttons

Forward: 30 Seconds.

Back: 15 Seconds
Headphone Controls: ) Next Episode / Previous Episode
Skip Forward / Skip Back

1 an episode contains chapters, next and
previous wil navigate between chaplers, then
episodes

Open the Podcasts app’s Preferences window and you The Advanced tab in the Preferences window gives
can configure the app to your own needs. You can access to some very important controls. You can choose
change the skip buttons’ timing from the default 30 or 15 whether or not to sync your subscriptions across your Apple

seconds, set headphone controls, choose whether to play one devices, automatically delete episodes you've already listened
episode at a time or continuously, and more. to and show Siri suggestions too.
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For Catalina, the Find My Friends and Find My app are merged into a single
app, ‘Find My’. With it you can keep track of your friends’ whereabouts, and

also track down a missing Mac, iOS device, Apple Watch or AirPods. It's
great if you're arranging a meeting, or finding lost or stolen Apple gear.

The People Tab

‘Share My Locatien Send

The Find My app is divided into two sections, represented To start sharing your location with friends or family members,

by tabs at the top of the sidebar; People and Devices. tap the Share My Location link at the foot of the sidebar. You
Unsurprisingly, the People tab is for finding friends and family who ~ should then enter the name, Apple ID email, or phone number of
are sharing their locations. If it isn't already selected, tap it. the person with which you want to share locations.

3 As is usual, you can tap the + sign to the right and select The people with whom you shared your location can now
a person from your Contacts app. Add as many people see exactly where you are, that is the blue spot which
as you wish, and tap the Send link. Then you can choose you can see on the map. You can pinch and spread to zoom

whether to share for an hour, the rest of the day, or indefinitely. into and out of on this map, just like you can in the Maps app.
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Diractions.

Netifications

Add.

To access this options window, tap on the name of someone

with whom you're sharing your location and click the %’ icon
on the tab next to their photo on the map. From here, you can tap
Contact to bring up their card from your Contacts app.

File Edit View Window Help § 40 O i F 4 00xBl B® Mona3Spm L Q)
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Notity Alison Willis

Wnen | Arrive

When| Leave

o My Currant Locstion
Alson Wikis's Current Location

Add Location

Remove Alison

Other options available on this screen are: ask for their

location, stop sharing your own, or remove them from the
people with which you're sharing. You can also send them a
netification when you leave or arrive.

@

Add..

@ James Cale

Ask To Follow Location

Stop Sharing My Location

7 Click on a friend who isn't currently sharing their location
with you, click on the " icon and then tap Ask To Follow
Location to request they do so. If they comply, they also appear
on the map, along with yourself and others.

Returning the Favour.

0 You want o share yours?

i @

Share Your Location

Share for One Hour

Share Unil End of Day
Share Indefinitely

Don't Share

When someone shares their location with you, it appears
in your sidebar and you're given a notification. You can
return the favour from either of these indicators, and
share your location with them.
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* Contact Directions
£ Notifcation

Something else you can do from the i icon’'s pop-up

window is get directions to your friend’s location. Just click
the Directions option, and you're shown how to get there. Clicking
Contact opens their contact card.

The Me Option.

QT

€, Lo

@ e = - -

& ovoan @©
o eerianenes @D

K" nocowe Location Updates

Tap Me in the sidebar. Click the i’ in the tab showing you
on the map. A pop-up window identifies your location,
which you can name (work, home, school, and so on).
You can also stop sharing your location too.
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The Devices Tab

Alison's MacBook
No location found

tans Mac
No location found

Mac Pro
Mo location found

The Devices tab, found at the top of the sidebar, gives

access to what used to be called Find My Mac. Tap it, and
any Apple gear you own that's logged into the same Apple ID as
your Mac is shown on the map.

fan Osborne’s iPhone

Play Sound Directions.

Notifieations

Notify When Found

®

3 Tap a device on the map or list and then the ' next to its

map icon for an options screen. To locate a device that's

likely to be within earshot, tap the Play Sound link. Your device
makes a noise, enabling you to find it.

Mark As Lost?

Lost Mode fets you lock and track a missing iPad. You can alse
provide contact information in case someone finds this iPay

£
; ; | -
= |

This Mac 1an Osborne's iPad Air

ne’s iPad Alr

Ian's MacBook
= oo

an.osborne@dsl pipex co

e o

Continue:

If you fear a device is completely and irretrievably lost, as

opposed to simply being mislaid in the house or at work,
you can tap Mark as Lost to lock and track the device. This
prevents thieves or finders getting at your precious personal data.

W . o

The sidebar on the left of the window shows your Apple gear.

If a device hasn’t been online recently; it is listed as 'No
location found'. Its location will be updated when it next goes online,
so if i's been stolen, keep checking back.

Detaiis »
East Street = : )
| route - . % lan Osborne’s iPad Air

Ntifications

Notify When Found

9.

Tapping the Directions option opens up the Maps app

and gives you directions from your current location to the
whereabouts of your missing device. As you can see, this one
isn't too far away; maybe it was dropped in the street?

Enter Phone Number | bl

This phone number can be used when someone finds yos

wants to contact you.

Updating location. | 9

lan's MacBook " 1en Found
Pro
0345 678921

When you lock a device, you can enter a phone number

and a short message, which is displayed on the
gadget’s lock screen. This way, an honest finder can see the
message and give you a ring to say they found it.
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To access this options window, tap on the name of someone
7 with whom you're sharing your location and click the %’ icon
on the tab next to their photo on the map. From here, you can tap
Contact to bring up their card from your Contacts app.

ece = %
L %,
pecsie oavices %,
< B Done
1an Osborne's iPad Air
v
Notifications
o5m
0345678921
e o
with Yo — Mark As Lost
Aetivated
Tris Pad has boan ost. Plsase call ma.
m AMison's MacBook
Naocation found
Mac Pro
Erase This Device

Receive Email Updates
g ©

Other options available on this screen are: ask for their

location, stop sharing your own, or remove them from the
people with which you're sharing. You can also send them a
notification when you leave or arrive.

fy Fle Edt View Window Help

Erase iPad?

All content and settings will be erased when this iPad connects to
the internet. An erased iPad can no longer be located or tracked.

ne'siPad Air

lan's MacBook
= o

This Mac + Updating
lozation

D et

As a last resort, you can tap the Erase this Device option

to wipe it clean of all information. This should only be
done if you've given up all hope of ever recovering it, as, when
it's wiped, it can no longer be tracked using the Find My app.

Map Functions.

The Find My app draws its maps from the Maps app, so
shares some of its functionality too. Like in Maps, you can tap
the arrow icon in the bottom right to home in on your current
location, or that of the person/device selected in the sidebar.

© Shars My Location oo birbed Setaie 9 | [=]+

Like in Maps, you can pinch and spread on the screen to zoom
into or out of the map. You can also click and hold with one
finger, to drag the map around the screen and tap the 3D icon
to switch between 2D and 3D viewing.

fie_Eat RISl Window Fielp

0 Alisol  gnter Full Screen

@ James Gale
I6 Cansas your location

© Share My Location

Tap the tabs at the foot of the map and you can switch
between a drawn map, a satellite view and a hybrid, that is,
a satellite map with street names overlaid. Also, switch
between miles and kilometres in the View > Distance menu.
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News App
Stories and Features

Another application that comes to the Mac from iOS is the News app. It's a
great way of collating news stories and features from around the world and
presenting them in one place. When you've customised it to suit your own
particular needs, it's an amazing source of information.

News File Edit_View Window Help.

LN Edit View Window Help
Suggest More Stories Like This %L
‘Suggest Fewer Stories Like This ®D
Save Story %S |

,
@ News
0 rows: 28 September
() spotignt
(D) saved Stories
0 sty Top Stories
Following Chosen by the Apple News ediitors.
@ Enadost
(B Buzzreed UK
News Top Stories:

Aston Villa FC
(@ Technology
{88 BBC Science Focus Magazine
(@ BBC History Magazine
0 soole
% Apple Newsroom
(S
B Aopleinsider
@ wirep UK
O The independent
@ Cult of Mac
() England Team News
D B3C News
D Newsweek

Follow Channel

. This s What Britain’s Biggest

Discover Channels & Topics...

hdanags Notficaton.. ConstructionProject Looks Like

Manage Blocked Channels & Topics... EDF's Hinkley Point nuclear project has already racked a $28 billion billand

Manage Subscriptions... astring of superiatives.
Close ®W —

B BuzcFeed Uk

News Top Stories.

Aston Villa FC

@ rechnology

& BBC Science Focus Magazine

@ 88C History Magazine

NEWS EDITORS' PICKS
Eight must-see
moments from
another dramatic
week in British
politics

“He should be absolutely
ashamed of himselt

om
Borls Johnson reported
to police watchdog over

[ero: ] i
Prince Harry meets same  Labour

When you first open the News app, you see a sidebar When you open a news story, if it has a video it can be

and a main window. The sidebar’s Today option is watched within the News app. In the File menu, there’s
selected, giving you a range of the day’s top stories. Click ona  an option to open the story in Safari. This takes you to the web
story to open it and read it in full. page from which the story was drawn.

Suggest More Stories Like This L
Suggest Fewer Storles Like This %D e t Q e 8 < oD
Save Story S
Open in Safar

T & ivore
Unfoliow Channel anL q @ sr05Mac
Block Channel %D 4 Y Celebrities
Discover Channels & Topics... - | = 1 o Brexit
Manage Notifications. . ] - ! ) \ oy Video Games
Manage Blocked Channels & Topics... ’ [ / 4 () The verge.
Manage Subscriptions... “ \ \ ) e Registor
Close ?ﬂﬂ e, e § ) Der Spiagel
) BuzzFeed UK s 4 { 3

[ -] & W " ® e

[ED News Top Stories P e i E Premier League

2 Aston Villa FC { ¥ { £ 7 ([ Mieror Online

Technology / > =~ Metro.co.uk

& B8C Science Focus Magazine / y ® the guardian

& EBC History Magazine '

[« P

«% Apple Newsroom

o . N WV w ! UK to ban import of
» ‘_ = '

Suggested by Sirl

S s\ trophy hunting souvenirs

& The = BIG STORY

S . . to help endangered
(Bl e et The rise and rise of animals

the Instagram face e

The UK is set to ban the import of sick souvenirs from hunting, it has
7 Nows Editors’ Picks Influencers have inspired a wave of new beauty treatments — emerged.

3 The Spotlight option gives you a selection of features In the sidebar section titled ‘Suggested by Siri’, you see
chosen by Apple’s editors. If you find a story you various subjects the News app thinks might interest you.
particularly like or dislike, choose the Suggest More or Fewer The stories work just like in the other sections; click one to

Stories Like this in the File menu to improve future suggestions. open it, click the chevron in the top-left to go back a page.
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In the File menu is an option called Discover Channels &

Topics. Click it for a range of news sources and subjects
for you to choose from. Click the plus sign in the corner of any
you especially like.

eve News th iQ
Apple News Science
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O saved Stories momentous !
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& politics e (o]

Researchers are digging deep intothe  Despite Fix, Samsung
© Picks Antaret heln s fioure ot Earshy i Still

Scroll down the window for more channels and topics.
Select as many or as few as you like. When you're
finished, click the Done button at the bottom. Your new sources

have been added to your sidebar.

TOP RESULT

MacOS Catalina might be released as early as next week

STORIES

tectradr

Did i
of October 47

Meet Catalina the cat at Harris County Animal Shelter

Apple rumored to launch MacOS Catalina niext week, ahead of
October event

7 In the top right corner, you can see a search field. Enter
a search term for a subject or source you're interested in
and you're given a list of individual stories, and channels,
which write about that subject.

Suggest More Stories Like This %L
Suggest Fewer Stories Like This %D
%S

g

/" Suggest Mo .
nformation leaks

SRR uggets MacOS
atalina arrival next

If you come across a news story you'd quite like to read

but don't have the time, select Save Story in the File
menu or type CMD-S. Click Saved Stories in the sidebar to see
the pages you've saved.

CHANNELS

B seorsustatea +
VF  vanity Fair +
The Ecanomist o

Reuters

[} cosmopolitanuk

(=

Scientific American

Copy Link

Block Channel g0 Lero

TopiCS

u Catalonia

B3 consoiated e Gataiina

Santa (California}

Scroll up the search results for a list of channels and topics

relating to the search. Click the plus sign to add that
channel or topic to your sidebar. To remove a channel or topic,
right-click on it and then select Unfollow.

File Edit View Window Help 3 O B F = W) 0GR A

MacOS Catalina might be released as carly as next week

mrEr@u
‘The epic engineering behind drilling 3,000 metres into the
Antarctic ice

L=
The Unstoppable Rise of the ‘Instagram Face'

NEWS EDITORS' PICKS
‘This week’s best reads, selected by the Apple News editors

This Is What Britain's Biggest Construction Project Looks Like

If you want to go back to a story you've previously read, it

can be found in the History section near the top of the
sidebar. Click this and your reading history is listed; click a story
to open it once more.
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Photos App
Manage Your Images

With the release of macOS Catalina, the
Photos app goes from strength to strength.
Once again, you can edit your snaps to
get the best from them, store them in the
app, arrange them into albums, watch
them as slideshows and even create
books, calendars, greetings cards and wall
prints. Here’s a guide to what you can do

with the Photos app.

Use this button to toggle

between regular thumbnails of
your photos, as seen here, and
square-shaped images that leave
little border.

This slider increases and

decreases the size of your
preview images. The larger these
thumbnail previews, the easier it is to
see the photos, but smaller previews
allow more pictures to be seen on
the screen.

Use these buttons to view your

photos arranged according to
the year, month, or day in which they
were taken.

Click here to see all your

photographs in the Photos
app, arranged as thumbnails.
Double-click on a thumbnail to open
a photo.

This button opens the

information window. You can
use it by selecting a preview or
opening a photo. The information
window gives information on the
picture and the camera on which it
was taken, it also lets you add names
to the people in it.

The Share button lets you add

the picture to shared albums,
send it using Mail, AirDrop,
Messages and more.

7 Choose a photo and click the
Heart button to identify a
picture as one of your favourites.

Rotate the image 90%

anti-clockwise. Hold Alt to turn
it clockwise instead. Useful if a
picture that's been imported is not
the right way up.

The search field. Thanks to

machine learning, you can
search for terms like ‘birthday’,
‘holiday’ or ‘Christmas’ to find photos
taken on these occasions.

These sidebar options

represent different ways of
viewing photos found in your library.
Photos shows all your photos,
Memories arranges them into
groups, Favourites shows your best
pics, and Places groups them
according to where they were taken.
Recents, Imports, and Recently
Deleted are self-explanatory.

Library
& Photos
£») Memories
Q) Favourites
2 People
(I) Places
&] Recents
Imports
1l Recently Deleted

Shared

D Activity
»> lf] Shared Albums )

™

Albums
> [ﬁ Media Types
> [ﬁ My Albums

Projects

B ﬁ] My Projects




Photos you've shared

on iCloud are listed in
Activity, and Shared Albums
shows the albums in which
they were shared. Hover over
Shared Albums and click the
plus sign to start a new,
shared album, into which you
can add pictures you wish to
allow friends and family to
view on their own computers.

Years Months Days All Photos

19 Jul 2019

MacBook
.

Your local albums.

Media Types groups
pics as videos, panoramas,
selfies and more, and are
automatically updated when
you add new media to the
app. My Albums shows
albums you've put together
yourself. Photos added to
albums are not removed from
the main Photos section.

100% @3 S =B

If you put together a

book, calendar, card,
print, wall decor, or slideshow
based on your photos, they
appear here. Apple no longer
sells prints themselves, but
you can get apps from the
App Store for third-party
services. Hover over My
Projects and click the plus
sign to start a new project.

6 7 8

These are the dates

between which the
currently visible pictures were
taken and the locations.

Your pictures, arranged

as thumbnails. Click on
one to open it, after which you
can swipe through them or
choose one from the preview
bar under an open photo.

Mon1047am @ Q & =
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The Editing Tools

BN & riters

& crop

4| Neutral Grey

You can edit an open photo. Use the Wand tool to

automatically enhance your pic, or click the Edit button
to make manual adjustments. In Editing Mode, the Edit button
changes to ‘Done’. Click this when you've finished your edits.

o s T R 5

ADJUST

f_!, Crop

Click a triangle in the sidebar to open a tool. The Light,
Colour and Black & White tools give you sliders to
increase or reduce the brightness and saturation, or switch to a
monochrome image. Click the Options triangles for more

advanced tools.

>
»O
> B

(5

»

v ) White Balance

*| Temperature / Tint

Tempen‘-ature ) I

In White Balance, select the feature to adjust with the

pull-down and use the slider to change it. Levels take
time to master. Hover your pointer over the graph and drag the
dots at the foot of the vertical lines to adjust.

Edit With.

Right-click on an open photo and you get a sub-menu.
Hover over Edit With and, if you have third-party photo
editors on your Mac, you can open the photo in one of
them and then edit it using that app. Edits are carried
over into the Photos app.

- AR AL, A )

. + Luminar Flex
Teignmouth, England, United
22 August 20150t 13:3413 - 21 4 preview

21 Affinity Photo

& Affinity Publisher

© Amadine

« Analog Efex Pro 2

4 Aquarelo

cae evert to Origin:
CleanShot -

& Color Efex Pro4

% ColorSync Utility

« Dfine2

/3 0x0 PhotoLab 2

© Flume

€ Google Chrome

« HDREfexPro 2

© Icondar

& Image Tricks Lite

& Inboard

® Luminar Flex

& Luminar Flex (1.0)

3 Retouch removes unwanted objects from a picture.
Click the brush, then click and drag to paint over the
object. Let go and it's removed. Red Eye lets you paint out
red pupils caused by camera flash. You can adjust the brush
size with both tools.

In Curves, drag the diagonal line or the dots under the

right and left ends. A useful trick is to click on the left
dropper and click something black, then the right dropper and
click on something white. The Definition tool is another slider.



Selective Colour and Noise Reduction are sliders. The former

lets you make adjustments to one colour at a time, using the
pickers and sliders, and Noise Reduction is for smoothing out
speckles and other such imperfections in the photo.

Vivid Warm

Select the Filters tab and you can automatically add an

effect to your photo. Here we’ve gone for Vivid Warm but
you can also set it cooler, make it monotone and more.
Choosing another filter to overrides the last one. Choose
Original to remove all filters.

Reset Adjustments

Edits made in the Photos app are non-destructive. This

means whatever you've done to your picture can be
reversed. If you don't like your edits, just click the Reset
Adjustments button in the bottom right corner and your photo
reverts to its original settings.

'

75 % = <) B8 Fi19:40

Image View Window Help

& o

7 The Sharpen tool lets you sharpen pictures that are out of
focus. You can sharpen the edges, adjust the intensity and
more. The Vignette option lets you add an adjustable shadow to
the edges of the photograph, as you can see we've done here.

B Adjust

Use the Crop tab to rotate your photo if it isn't straight

and also to crop it by dragging the corners into the
photo. The Flip option in the sidebar mirrors the pic and
Aspect lets you resize the photo according to an aspect ratio
of your choice.

Universal Tools.

All the options in Edit Mode have these three tools,
which appear when you hover over or open one of the
settings tools. The curly arrow reverses the last
adjustment you made. Auto makes an automatic
enhancement with that tool only and the tick in a circle
toggles the last edit you did on and off, so you can see
the difference it has made.

» O Colour

v (D Black & White

» Options

» 4 Retouch
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Adding People

- e T T TS ES I —— ——
O Favourites
& Pecple Appie Phane 5 (o
Sower oo e s
s e e
B impons
18 Recently Deleted
el
| 9 Snared Albums
l-p—
> €5 My Albums.
iy
Open a photo containing people and click the ‘i’ button Click ‘People’ in the sidebar to see photos you've
for the information window. If the Photos app has identified by name. Click on a person to see all the
identified a face, it's shown in this window. Click it to tag the photos you have of them. If a photo doesn’'t contain that
face with the person’'s name. Click the plus sign to add person, right-click on it and select the option ‘X is not in this
another tag, which you can name and move should there be photo’ to remove it. Scroll down and click Confirm Additional
a face that isn't identified. Photos to check pics the app thinks are of that person.
Project
eve Print and publish your photos ] Done
Senda card
Create individual birthday cards, or order haliday or party cards in bulk.
&
.Bvok » @ App Store.. P
Ewuﬂggﬂ iy
[ wall Decor >
) Prints » Create a calendar
gz:::hw : S:thn and print a calendar with your favourite photos as the featured images for each
© Manage. | i
e == o
You can still order prints and design books, calendars Choose an extension offering the project you want, and
and cards with Photos, but Apple no longer sells them. install it. Then choose the pictures you want to import
Instead, hover over Projects and select the project you want into the project (hold CMD and click on them one by one),
to start. Apps you have downloaded for the purpose are then select the extension in the menu shown in the previous
shown, as is an App Store link taking you to extensions step. You can then follow the instructions offered on-screen to
offering these third-party services. build and print your project.
Memories
u;.:ho\sl
© Favourites.
& People.
&, Praces
) Recents.
B imports.
T Recently Deleted
£
() Shared Albums
;-:nuﬂvnu
b £ My Albums
Iy
Click on Memories in the sidebar to show photos Click on @ memory and hover over the picture at the top
grouped according to various factors, including time to see a Play button. Click it for a slideshow. Hover over
and content. For example, a series of pictures taken over a the slideshow for controls. Click the cog to change the
week in a certain location might be identified as a holiday. background music. Right-click on a memory and you can

Catalina also picks your best shots too. delete it, or add it to your favourites.




Making New Albums iCloud Photos.

@ Favourites

Apps on this Mac using iCloud:

- People

<I> Places iCloud Drive Options.

(4] Recents. & Photos

Imports.

lan Osborne 4
10 Recently Deleted ian.osborne@dsl pipex.com \
9 ontacts
Shared 8 <
[

© Activity Wy Overview m Calendars

p () Shared Albums . Name, Phone, Email .
[ _/ Reminders
Albums. \L) Password & Security
b () Media Types @ soi
| Payment & Shipping
p 5 My Albums (] Z - Notes
Album e 2
Projects. "l
Iv () My Projects ¥ Smart Album ! & (Cloud € sii
£ Folder — Optimise Mac Storage

Media & Purchases
— The full contents of iCloud Brive will be stored on this Mac if you have
enough space. Older documents will be stored only in iCloud when space is
needed.
lan’s MacBook Pro
W Vacsook Pro13 0 ;
e iCloud Storage: 50 GB (9.52 GB Available)

Apple TV
® oo v ak Bl sscs Manage.
2 lan Osborne’s iPad...

Pad Alr 2 2

lan Osborne's iPho...

CTRL-click on the pictures you want to make into an To share a photo with iCloud, first go to System Preferences

album, then hover over My Albums in the sidebar. Click > Apple ID > iCloud and make sure the Photos option at the
the plus sign that appears, and choose whether to make a top of the list is ticked. You can then upload photo albums to
regular album, a smart album, or a folder from your pictures. iCloud and share them with others.

e (1 Years Months Days All Photos @ 0] < o

Shared Albums. ®

Smart Album Name: I Untitled Smart Album
Match the following condition:

Proto B - -

hidden

Shared Albums

edited
6 items matched RAW cancel | TN

HDR

T
Best Photos Family

Shared with Shared by You

video
selfie

[
Live Photo .
portrait shak
panorama
time-lapse
slo-mo

Monaco
burst

screenshot
animated

P AlyssaFaicon~
referenced

tagged with GPS

unable to upload to iCloud Photos

We had fun over theref

Create

If you choose a smart album, you can set rules. From To start a shared album, hover over the Shared Albums

then on, any photo you add to your Photos app that option in the sidebar and click the plus sign that appears.
satisfies these rules is automatically added to your smart Give your new album a name, invite people to view it and
album. Set its title in this window too. make any comments you wish.

o8 (| o— -m My Albums ® ) o Q —

=7 Back Garden Shared ON O A A

£ Mamories AprlZ013 125hctes  Show as Mamoey  Sideshow

eo  Add photos and videos @  wing: Al items|

lan Osborne v Alyssa Falcon~

Subscribers Can Post

You and the people you invite can add
photos and videos to this shared E
album.

Public Website

Allow anyone to view this shared
album on iCloud.com

Notifications
Show notifications when subscribers
like, comment, or add photos o
videos to this shared album.

Choose a regular aloum and you can give it a name. Go back to Photos, in the sidebar, and then drag pics and
The new album appears in your sidebar; click the videos into the new, shared album. Click the Silhouette
triangle next to My Albums to see them all. You can drag icon, in the top bar, to invite or uninvite people and set a

photos onto this album to add them to it. few more options. People you invite get a message.




Going Further with Your Mac and Catalina ’

2 Glossary of Mac and
o Computing Terms

We've tried to keep this guide as jargon free as possible, but inevitably there
are some words and phrases that might still seem mysterious to the newcomer.
Where that’s the case, this glossary should help. If you're confused by a
technical term, take a look; you might just find the definition you need in here.

A

Accessibility: A series of tools
and features designed to
make an Apple device such
as the Mac and mobile
devices easier to use by
those with disabilities such
as vision or hearing
impairments. You can find
the Mac’s Accessibility
features and customise them
in System Preferences.

AirPlay: A protocol for
streaming sounds and video
from an Apple device to a
set of compatible speakers,
or a device such as an
Apple TV. It's wireless, and
easy to use as well.

App: Short for ‘application’,
another name for a
computer software program.
Your Mac comes with a
selection of pre-installed
apps, and you can buy more
from the Mac App Store.

App Store: The App Store is
where you can download free
and paid programs to your
device using your Apple ID.
You can access it through the
application that comes
bundled with your Mac.

Apple ID: This is the email
address and password that
you have registered with
Apple. It's required to
access many online
applications on your Mac,
including iTunes, App
Store and Books.

Apple Menu: The menu that's
opened by clicking on the
Apple icon in the left of the
menu bar. It gives access to
system functions such as

Preferences, App Store,
Force Quit and more.
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B

Bluetooth: Bluetooth is a
wireless technology used to
link and exchange data with
another compatible device. It
has a range of approximately
8 metres (25ft). The Mac
supports many Bluetooth
devices, including
headphones, keyboards and
fitness trackers.

Books: This is Apple’s eBook
application, which is
available for free from the
App Store and is also
bundled with recent
versions of macOS. It
handles the standard
electronic publishing
formats protected by
FairPlay DRM, and also
PDF documents. It was
introduced in 2010 along
with the iPad.

Browser: An app used to
access websites found on
the worldwide web. The
Mac comes with Apple’s
Safari browser preinstalled,
but others are available in
the App Store.

C

Calendar: This is one of Apple’s
preloaded apps. Use it to
keep track of events,
invitations, and reminders
on your Mac, iPhone, iPod
touch and iPad.

Closed Clamshell Mode: By
connecting your notebook
Mac to a display, an external
keyboard and a controller
such as a mouse or Magic
Trackpad, you can use it like
a desktop computer, with the
notebook closed.

D

Desktop: A computer thats
designed to be used on a desk
while plugged into the mains, at
home or in the office, as
opposed to a notebook or
laptop. Apple’s range of
desktop computers is the iMac,
the Mac mini and the Mac Pro.

Dock: The opaque strip at the
bottom of the screen. Apps
in the dock are easy to
access and open, and you
can customise it to best suit
your requirements. Apps
that are currently running
are also shown in the dock.

E

Emoticon: A small drawing
used to augment a message
or text. Typically, these are
yellow faces showing a
variety of expressions.

F

Facebook: Currently the most
popular social networking
site on the Internet. Add
your Facebook account to
your list of Internet Accounts
in System Preferences and
you can share material
directly to it using the
macOS Share button.

FaceTime: You can make video
and audio calls to other Apple
devices using the FaceTime
app. These are made over
the Internet so are free
unless using mobile data.

Finder: The Finder is the Mac's
user interface. It deals with
management of folders,
windows, menus and more.
Its feature set has grown over
the years, with recent
introductions including tabbed
Finder windows and tags.

Folders: A folder is a container

for a group of apps or files.
You can create one by
using Finder’s File menu, or
right-clicking on the desktop
and using the contextual
menu. You can drag items
into and out of a folder.

Force Quit: The act of forcing

an application to close
down, perhaps because it's
crashed or frozen. It's
achieved by right-clicking its
dock icon, or opening the
Apple menu and selecting
Force Quit. Unfortunately,
unsaved work will be lost.

G

Gestures: These are actions

performed with your fingers
on the Mac'’s trackpad.

You can use gestures on a
notebook trackpad, an
Apple Magic Trackpad or to
a limited extent, an Apple
Magic Mouse.

Gumdrops: A colloquial term for

the three coloured buttons
found in the top left corner of
an app or finder window.
They close the window (red),
minimise the window (yellow)
or switch to and from
full-screen mode (green)

H

HTML: Hypertext Markup

Language, the standard for
building websites, and a
cornerstone technology of
the worldwide web.

iCloud: The collective name for

Apple’s online services, it
replaced MobileMe and
integrates with all iOS/
iPadOS and macOS/OS X
Mac computers.



iMessage: A text message

that's sent from one Apple
device to another.
iMessages use the Internet
rather than the mobile
phone network, so they’re
sent free of charge from
iPhones and iPads.

iOS: Apple’s mobile operating

system. iOS is the software
that powers the iPhone, iPod
touch, iPad and Apple TV.

iPadOS: The latest operating

system used by the iPad. It
evolved from iOS.

iTunes: Apple’s abandoned

music playing software,
which was also used to
activate and sync iPads and
iOS devices. In macOS
Catalina, iTunes was
replaced by three new apps;
Music, TV and Podcasts.

LaunchPad: Found in the dock

represented by a rocket
icon, the LaunchPad is an
easy way of opening apps.
It resembles and behaves
like an iOS Home screen.

Lightning: The cable connection

used by modern iPads and
iPhones. It replaces the old
30-pin dock connectors, and
is used to charge these
mobile devices and sync
them with your Mac.

Location Services: Features

and software on your Mac
that pinpoint and use your
current location. The Maps
app is one example.

SMS text messages and
MMS multimedia messages.

MMS: Multimedia Messages

(MMS) supports images,
videos, sound, contact
cards, and location data.
Sent and received via the
Messages app on the Mac
to other Macs and mobile
cell phones.

Monitor: Also called a display,

this is an external screen
that's essential for Mac
minis and Mac Pros. You
can also add a monitor to
an iMac or notebook Mac
as a second or even
primary display.

Mouse: A controller used to

move your pointer around
your Mac’s screen, and to
select options using the
mouse buttons. A mouse is
traditionally used with a
desktop computer such as
the iMac or Mac Pro, but if
you don't like trackpads,
you can use one with your
notebook too.

N

Notebook: A portable computer,

sometimes called a laptop.
Notebooks can be mains or
battery powered and have
their own built-in screen,
which folds down for
portability. Apple’s notebook
range comprises of the
MacBook, MacBook Air and
MacBook Pro.

Notification Centre: A list of

recent notifications,
accessible by clicking on
the icon in the top-right
corner of the Mac’s desktop.
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making the on-screen images
very smooth and clear.

S

Safari: Apple’s web browser,
similar in function to
Microsoft Explorer or Google
Chrome. It's available for
both Macs and iOS/iPadOS
devices, and it lets you surf
the worldwide web.

Siri: Apple’s voice activated
digital assistant. You can
give Siri spoken instructions
and the service replies by
giving you the information
you asked for; or by
activating the requested
Mac function.

SMS (Short Message Service):
Text messages sent from
the Messages app from a
Mac’s Messages app or
mobile device such as the
iPad or iPhone to other cell
mobile phones.

T

Tablet: A computer in a flat,
‘tablet’ form factor, such as
the iPad. While the iPad is the
most popular tablet computer,
other models are available.

Text Field: Any area of the
screen where you can add
text. For example, when
completing a web form, there
are text fields for things like
your name, address and
more. Tap on a text field to
bring up the cursor, so you
can start typing.

Thunderbolt: A high-speed
connectivity port offered on

U

URL: Uniform Resource
Locator, the address used
to access a web page. For
example, Apple’s URL (its
website) is www.apple.com.

USB: (Universal Serial Bus) an
industry standard for
connecting computers and
peripherals introduced in the
mid-Nineties. The latest
version, USB-C, has a
similar plug to Thunderbolt
3, and is compatible with
Thunderbolt 3 ports.

\'/

VPN: (Virtual Private Network):
This provides secure access
over the Internet to private
networks, such as the
network at your company or
school.

W

Wi-Fi: A wireless means of
getting onto the Internet or
connecting two devices. At
home, your Wi-Fi network is
established through your
router. Whilst away from
home, you might have
access to public Wi-Fi
networks like those offered
in coffee shops or libraries.

Y

YouTube: The Internet’'s most
popular video viewing and
sharing service. Owned by
Google, you can access
YouTube through a web

macOS: Formerly known as OS
X, macOS is the operating P
system on which the Mac
runs. The current version of

recent Macs. A Thunderbolt
port can carry a video signal
as well as data, so it can be
used for an external display.

Touch Bar: The very latest

browser, or through a
dedicated app available for
the Mac, iPhone, iPad or
iPod Touch.

Photo Stream: Part of iCloud,

macOS is Version 10.15:
Catalina. Like most recent
versions of macOS,
Catalina is a free upgrade.

Mail: The Mac’s bundled email

client. It can handle a wide
range of email accounts,
including Apple iCloud
accounts, Microsoft's and
Google’s mail services,
Yahoo email accounts and
those accounts that are
provided by your Internet

Photo Stream stores your
last thirty days or 1000
photos online and on your
iOS/iPadOS devices, and all
your photos on your Mac.

Photos: A bundled Mac

application that lets you
store, manage and edit your
photo collections and share
them with your other Apple
devices using iCloud.

models of the MacBook Pro
replaces the function keys
with a touch-sensitive
screen which displays
functions and controls
according to the app or
feature you’re currently
using. It also has a Touch
ID fingerprint scanner for
unlocking your Mac.

Trackpad: The controller device
used in notebook Macs. You
control your on-screen pointer

& Finder File Edit_View Go  Window _Help

Q

QuickTime: Apple’s 2D video
and graphics player, used to

by dragging your finger across
the trackpad. Apple’s Magic
Trackpad is available for
desktop computers.

Service Provider. Third party
email apps are available.

Menu Bar: The macOS Menu

Bar sits atop the desktop, at
the top of the screen. On
the left are pull-down
menus, which vary
according to what app
you're using. On the right
are menulets and controls,
along with info such as the
time and date.

Messages: One of Apple’s

built-in apps that handles

play movies and other video
on your Mac.

R

Retina Display: This is Apple’s

term for its high-resolution
screens. The pixels are so
small it's impossible to
distinguish between them at
a normal viewing distance,

Twitter: One of the most
popular social networks
built around a follower/
following system rather
than friends, with
messages limited to 140
characters. There’s an
official Twitter app for the
Mac, and several third
party options for sending
Tweets too.

POOURBBO
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Now you’ve got the basics
down, you can improve and
learn more essential skills in
our next guide...

MAC OS

CATALINA

Coming soon!
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